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IPS File List

The following files are part of Cisco IPS 7.1(5)E4:
e Readme
- IPS-7.1-5-E4.readme.txt
e Minor Version Upgrade Files
— 1PS-4240-K9-7.1-5-E4.pkg
- IPS-4255-K9-7.1-5-E4.pkg
- IPS-4260-K9-7.1-5-E4.pkg
- I1PS-4270_20-K9-7.1-5-E4.pkg
- IPS-4345-K9-7.1-5-E4.pkg
- IPS-4360-K9-7.1-5-E4.pkg
— IPS-SSP_5512-K9-7.1-5-E4.pkg
— IPS-SSP_5515-K9-7.1-5-E4.pkg
— IPS-SSP_5525-K9-7.1-5-E4.pkg
— IPS-SSP_5545-K9-7.1-5-E4.pkg
- IPS-SSP_5555-K9-7.1-5-E4.pkg
- IPS-SSM_10-K9-7.1-5-E4.pkg
— IPS-SSM_20-K9-7.1-5-E4.pkg
— IPS-SSM_40-K9-7.1-5-E4.pkg
- IPS-SSP_10-K9-7.1-5-E4.pkg
- IPS-SSP_20-K9-7.1-5-E4.pkg
- IPS-SSP_40-K9-7.1-5-E4.pkg
- IPS-SSP_60-K9-7.1-5-E4.pkg
e System Image Files
- IPS-4240-K9-sys-1.1-a-7.1-5-E4.img
— IPS-4255-K9-sys-1.1-a-7.1-5-E4.img
- IPS-4260-K9-sys-1.1-a-7.1-5-E4.img
- IPS-4270_20-K9-sys-1.1-a-7.1-5-E4.img
— IPS-4345-K9-sys-1.1-a-7.1-5-E4.img
— IPS-4360-K9-sys-1.1-a-7.1-5-E4.img

Release Notes for Cisco Intrusion Prevention System 7.1(5)E4
n. 0L-26774-01 |



Supported Platforms

— IPS-SSP_5512-K9-sys-1.1-a-7.1-5-E4.aip

— IPS-SSP_5515-K9-sys-1.1-a-7.1-5-E4.aip

— IPS-SSP_5525-K9-sys-1.1-a-7.1-5-E4.aip

— IPS-SSP_5545-K9-sys-1.1-a-7.1-5-E4.aip

— IPS-SSP_5555-K9-sys-1.1-a-7.1-5-E4.aip

— IPS-SSM_10-K9-sys-1.1-a-7.1-5-E4.img

— IPS-SSM_20-K9-sys-1.1-a-7.1-5-E4.img

— IPS-SSM_40-K9-sys-1.1-a-7.1-5-E4.img

— IPS-SSP_10-K9-sys-1.1-a-7.1-5-E4.img

— IPS-SSP_20-K9-sys-1.1-a-7.1-5-E4.img

— IPS-SSP_40-K9-sys-1.1-a-7.1-5-E4.img

— IPS-SSP_60-K9-sys-1.1-a-7.1-5-E4.img
e Recovery Image Files

- IPS-4240-K9-r-1.1-a-7.1-5-E4.pkg

- IPS-4255-K9-r-1.1-a-7.1-5-E4.pkg

- IPS-4260-K9-r-1.1-a-7.1-5-E4.pkg

- IPS-4270_20-K9-r-1.1-a-7.1-5-E4.pkg

— IPS-4345-K9-r-1.1-a-7.1-5-E4.pkg

— IPS-4360-K9-r-1.1-a-7.1-5-E4.pkg

— IPS-SSP_5512-K9-r-1.1-a-7.1-5-E4.pkg

— IPS-SSP_5515-K9-r-1.1-a-7.1-5-E4.pkg

— IPS-SSP_5525-K9-r-1.1-a-7.1-5-E4.pkg

— IPS-SSP_5545-K9-r-1.1-a-7.1-5-E4.pkg

— IPS-SSP_5555-K9-r-1.1-a-7.1-5-E4.pkg

— IPS-SSM_10-K9-r-1.1-a-7.1-5-E4.pkg

— IPS-SSM_20-K9-r-1.1-a-7.1-5-E4.pkg

- IPS-SSM_40-K9-r-1.1-a-7.1-5-E4.pkg

- IPS-SSP_10-K9-r-1.1-a-7.1-5-E4.pkg

- IPS-SSP_20-K9-r-1.1-a-7.1-5-E4.pkg

— IPS-SSP_40-K9-r-1.1-a-7.1-5-E4.pkg

— IPS-SSP_60-K9-r-1.1-a-7.1-5-E4.pkg

Supported Platforms

Cisco IPS 7.1(5)E4 is supported on the following platforms:
o IPS 4240
e IPS 4255
e IPS 4260
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e IPS 4270-20

e IPS 4345

e IPS 4345-DC

e IPS 4360

e ASA 5500 AIP SSM-10
e ASA 5500 AIP SSM-20
e ASA 5500 AIP SSM-40
e ASA 5512-X IPS SSP

e ASA 5515-X IPS SSP

e ASA 5525-X IPS SSP

e ASA 5545-X IPS SSP

e ASA 5555-X IPS SSP

e ASA 5585-X IPS SSP-10
¢ ASA 5585-X IPS SSP-20
e ASA 5585-X IPS SSP-40
e ASA 5585-X IPS SSP-60

Supported Servers

The following FTP servers are supported for IPS software updates:
e WU-FTPD 2.6.2 (Linux)
e Solaris 2.8
e Sambar 6.0 (Windows 2000)
e Serv-U 5.0 (Windows 2000)
e MSIIS 5.0 (Windows 2000)
The following HTTP/HTTPS servers are supported for IPS software updates:
e CSM - Apache Server (Tomcat)
e CSM - Apache Server (JRun)

ROMMON and TFTP

ROMMON uses TFTP to download an image and launch it. TFTP does not address network issues such
as latency or error recovery. It does implement a limited packet integrity check so that packets arriving
in sequence with the correct integrity value have an extremely low probability of error. But TFTP does
not offer pipelining so the total transfer time is equal to the number of packets to be transferred times
the network average RTT. Because of this limitation, we recommend that the TFTP server be located on
the same LAN segment as the sensor. Any network with an RTT less than a 100 milliseconds should
provide reliable delivery of the image. Be aware that some TFTP servers limit the maximum file size that
can be transferred to ~32 MB.

Release Notes for Cisco Intrusion Prevention System 7.1(5)E4
n. 0L-26774-01



IPS Management and Event Viewers 1l

IPS Management and Event Viewers

Use the following tools for configuring Cisco IPS 7.1(5)E4 sensors:
e CiscoIDM 7.1.5
IDM 7.1.5 is included within the IPS 7.1(5)E4 files.
IDM 7.1.5 is included within IME 7.2.3.
IDM 7.1.5 requires JRE 1.6 or later.
You can use IDM 7.1.5 to configure IPS 6.2, 7.0, and 7.1 sensors.
e (CiscoIME 7.2.3
You can use IME 7.2.3 to configure IPS 6.1, 6.2, 7.0, and 7.1 sensors.
e IPS CLI included in IPS 7.1(5)E4.
e Cisco ASDM 6.3.4 and later.
Use the following tools for monitoring Cisco IPS 7.1(5)E4 sensors:
e IDM7.1.5
e IME7.2.3
e MARS minimum version 5.2 and latest version 6.0.5
e CSM 4.0 and later

~

Note CSM 4.0(2) does not support the IPS 4270-20.

~

Note  You may need to configure viewers that are already configured to monitor the earlier version
sensors to accept a new SSL certificate for the Cisco IPS 7.1 sensors.

New and Changed Information

Cisco IPS 7.1(5)E4 contains the following new and changed information:
e IDM7.1.5.
e Signature update S648.

e Adds the IPS 4240, IPS 4255, IPS 4260, and the ASA 5500 AIP SSM series back to the IPS 7.1(x)
line.

¢ Continuing support for the IPS 4270-20, IPS 4340, IPS 4360, ASA 5585-X IPS SSP series, and
ASA 5500-X IPS SSP series.

¢ Signature threat profiles—In the IDM and IME Startup Wizard, you can apply a signature template
to individual signature policies, which adjusts the signature coverage and response actions enabling
the sensor to make better choices in various deployment and threat scenarios.

>
Note  Signature threat profiles are supported on the IPS 4345, IPS 4360, ASA 5525-X IPS SSP,
ASA 5545-X IPS SSP, ASA 5555-X IPS SSP, and ASA 5585-X IPS SSP.
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New and Changed Information

HTTP advanced decoding— Enables deeper inspection of HTTP traffic.

~

Note HTTP advanced decoding is supported on the IPS 4345, IPS 4360, ASA 5585-X IPS SSP,
ASA 5525-X IPS SSP, ASA 5545-X TIPS SSP, and ASA 5555-X IPS SSP.

~

Note Enabling HTTP advanced decoding severely impacts system performance.

The default value of the Cisco server IP address has been changed from 198.133.219.25 to
72.163.4.161 in the Auto Update URL configuration. If you have automatic update configured on
your sensor, you may need to update firewall rules to allow the sensor to connect to this new IP
address.

Serviceability enhancements

— New show inspection-load command—When you execute the show inspection-load
command, it shows a timestamp and the current inspection load. When executed with the
history option, the show inspection-load history command shows a histogram of the
inspection load over the past 60 minutes and over the past 72 hours.

Use this command to determine the load on the sensor instead of the CPU Usage information
from the show statistics host command. The inspection load is a more accurate representation
of the processing level of the sensor.

The Processing Load category in the show statistics virtual-sensor output has been renamed
to Inspection Load Percentage and shows the same value seen in the show inspection load
command.

The calculation of the inspection load has also been enhanced to provide a more accurate
calculation of the sensor load at lower traffic levels.

— New erase license-key command—You can now delete an installed license from a sensor
without restarting the sensor or logging into the sensor using the service account.

— IPS bypass logs now indicate the reason the sensor is entering bypass.

— Detail information added to show statistics global-correlation [clear] command—The output
now includes any failures that have been detected and you can use the clear option to remove
the pass and fail logs.

— TCP Normalizer signature warning— You receive the following warning if you disable a
default-enabled TCP Normalizer signature or remove a default-enabled modify packet inline,
deny packet inline, or deny connection inline action:

Use caution when disabling, retiring, or changing the event action settings of a
<Sig ID> TCP Normalizer signature for a sensor operating in IPS mode. The TCP
Normalizer signature default values are essential for proper operation of the
sensor.

If the sensor is seeing duplicate packets, consider assigning the traffic to
multiple virtual sensors. If you are having problems with asymmetric or
out-of-order TCP packets, consider changing the normalizer mode from strict
evasion protection to asymmetric mode protection. Contact Cisco TAC if you require
further assistance.

— Reboot sensor warning—When a user reboots the sensor, a message with a timestamp is logged
so that the time of the reboot can be tracked.
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AC Power Supply in the IPS 4300 Series V01 and V02 Chassis W

e Asymmetric protection mode warning—Make sure anomaly detection is configured to inactive if the
sensor is monitoring asymmetric traffic. Using asymmetric mode protection with anomaly detection
enabled causes excessive resource usage and possible false positives for anomaly detection
signatures.

e Network participation enhancements

— In the case of SensorApp failure, the generated core.txt file will be sent with the network
participation update.

— Data gathered for the show health command has been added to the network participation
upload.

For More Information

e For more information about signature threat profiles, for the IDM/IME refer to Applying Signature
Threat Profiles.

e For more information about HTTP advanced decoding, for IDM/IME refer to Adding, Editing, and
Deleting Virtual Sensors, for the CLI refer to Adding, Editing, and Deleting Virtual Sensors.

e For more information about inspection load statistics, for IDM/IME refer to Displaying Inspection
Load Statistics, for the CLI refer to Displaying the Inspection Load of the Sensor.

AC Power Supply in the IPS 4300 Series V01 and V02 Chassis

The Cisco IPS 4300 series sensors with the AC power supply can restore the previous power state of the
system if AC power is lost. Earlier IPS 4300s (VO1) require you to turn on the power with the power
switch. Newer IPS 4300s (V02) automatically turn on when you plug in the power cable.

To determine your version, do one of the following:
e At the CLI, enter the show inventory command and look for VO1 or V02 in the output.
e On the back of the chassis, look at the VID PID label for VO1 or V02.
The VO1 chassis has the following limitations (these limitations do not apply to the V02 chassis):

e The sensor requires 50 seconds from the time that AC power is applied before the power state can
be updated and stored. This means that any changes to the power state within the first 50 seconds of
applying AC power will not be observed if AC power is removed within that time.

e The sensor requires 10 seconds from the time it is placed into standby mode before the power state
can be updated and stored. This means any changes to the power state within the first 10 seconds of
entering standby mode (including the standby mode itself) will not be observed if AC power is
removed within that time.

For More Information

For information on the AC power supplies in the IPS 4300 series sensors, refer to Installing the IPS 4345
and IPS 4360.
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Il TheIDMand JRE 1.7

The IDM and JRE 1.7

In IPS versions 7.1(1)E4 through 7.1(5)E4, the IDM fails to connect to the sensor due to a failure during

the initial handshake, because the web server is not RFC 5746-compliant. Try the following workaround.

Problem Cannot launch the IDM, when the IDM is running under JRE 1.7 with IPS 7.1(1)E4 through
7.1(5)EA4.

Solution Use JRE 1.6 or enable the SSL 2.0-compatible ClientHello format in the Java settings under
Control Panel.

The Sensor and Jumbo Packet Frame Size

Note

For IPS standalone appliances with 1 G and 10 G fixed or add-on interfaces, the maximum jumbo frame
size is 9216 bytes. For integrated IPS sensors, such as the ASA 5500-X and ASA 5585-X series, refer to
the following URL for information:

http://www.cisco.com/en/US/docs/security/asa/asa84/configuration/guide/interface_start.html#wp1328
869

A jumbo frame is an Ethernet packet that is larger than the standard maximum of 1518 bytes (including
Layer 2 header and FCS).

The ASA IPS Modules and Jumbo Packets

The jumbo packet count in the show interface command output from the lines Total Jumbo Packets
Received and Total Jumbo Packets Transmitted for ASA IPS modules may be larger than expected
due to some packets that were almost jumbo size on the wire being counted as jumbo size by the IPS.
This miscount is a result of header bytes added to the packet by the ASA before the packet is transmitted
to the IPS. For IPv4, 58 bytes of header data are added. For IPv6, 78 bytes of header data are added. The
ASA removes the added IPS header before the packet leaves the ASA.

Obtaining Software

Note

You can find major and minor updates, service packs, signature and signature engine updates, system
and recovery files, firmware upgrades, and Readmes on the Download Software site on Cisco.com.
Signature updates are posted to Cisco.com approximately every week, more often if needed. Service
packs are posted to Cisco.com in a release train format, a new release every three months. Major and
minor updates are also posted periodically. Check Cisco.com regularly for the latest IPS software.

You must have an account with cryptographic access before you can download software. You set this
account up the first time you download IPS software from the Download Software site.

You must be logged in to Cisco.com to download software. You must have an active IPS maintenance
contract and a Cisco.com password to download software. You must have a sensor license to apply
signature updates.
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Downloading Cisco IPS Software

To download software on Cisco.com, follow these steps:

Log in to Cisco.com.

From the Support drop-down menu, choose Download Software.
Under Select a Software Product Category, choose Security Software.
Choose Intrusion Prevention System (IPS).

Enter your username and password.

In the Download Software window, choose IPS Appliances > Cisco Intrusion Prevention System and
then click the version you want to download.

~

Note  You must have an IPS subscription service license to download software.

Click the type of software file you need. The available files appear in a list in the right side of the
window. You can sort by file name, file size, memory, and release date. And you can access the Release
Notes and other product documentation.

Click the file you want to download. The file details appear.
Verify that it is the correct file, and click Download.

Click Agree to accept the software download rules. The File Download dialog box appears. The first
time you download a file from Cisco.com, you must fill in the Encryption Software Export Distribution
Authorization form before you can download the software.

a. Fill out the form and click Submit. The Cisco Systems Inc. Encryption Software Usage Handling
and Distribution Policy appears.

b. Read the policy and click I Accept. The Encryption Software Export/Distribution Form appears.

If you previously filled out the Encryption Software Export Distribution Authorization form, and read
and accepted the Cisco Systems Inc. Encryption Software Usage Handling and Distribution Policy, these
forms are not displayed again.

Open the file or save it to your computer.

Follow the instructions in the Readme or the Release Notes to install the update.

Upgrading to IPS 7.1(5)E4

This section describes how to upgrade the IPS 4240, IPS 4255, IPS 4260, IPS 4270-20, IPS 4340,
IPS 4360, ASA 5500 AIP SSM series, ASA 5500-X IPS SSP series, and the ASA 5585-X IPS SSP
series, and contains the following topics:

e Upgrade Notes and Caveats, page 10
e Upgrading the Sensor, page 11

| oL-26774-01
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Upgrade Notes and Caveats

Pay attention to the following upgrade notes and caveats when upgrading to IPS 7.1(5)E4:

The default value of the Cisco server IP address has been changed from 198.133.219.25 to
72.163.4.161 in the Auto Update URL configuration. If you have automatic update configured on
your sensor, you may need to update firewall rules to allow the sensor to connect to this new IP
address.

If you are upgrading the IPS 4270-20 and you have a license for 6.0.x and earlier, you receive the
following error message:

Currently installed License is not valid in 7.1(3). Install a license that is
applicable for IPS versions 6.1 and above.

You must get a new license before upgrading your IPS 4270-20.

Anomaly detection has been disabled by default. If you did not configure the operation mode
manually before the upgrade, it defaults to inactive after you upgrade to IPS 7.1(5)E4. If you
configured the operation mode to detect, learn, or inactive, the tuned value is preserved after the
upgrade.

You must have a valid maintenance contract per sensor to download software upgrades from
Cisco.com.

For the ASA 5585-X IPS SSP series, you must be running IPS 7.1(1)E4 or later to upgrade to
IPS 7.1(5)E4. For the IPS 4270-20, you must be running IPS 6.0(6) or later. For the IPS 4340,
IPS 4360, and the ASA 5500-X IPS SSP series, you must be running IPS 7.1(3)E4. For the
ASA 5500 AIP SSM series, you must be running IPS 6.0(6)E4 or later.

A generic upgrade package is no longer available for the IPS 4240, IPS 4255, IPS 4260, and
ASA 5500 AIP SSM series. These platforms now have platform-specific filenames in accordance
with the 7.1(x) format.

This service pack automatically reboots the sensor to apply the changes. During reboot, inline
network traffic is disrupted.

You cannot uninstall 7.1(5)E4. To revert to a previous version, you must reimage the sensor using
the appropriate system image file

For More Information

For the procedure to download software from Cisco.com, see Obtaining Software, page 8.

For the procedure for using the upgrade command to upgrade the sensor, see Upgrading the Sensor,
page 11.

For the procedure for using ROMMON to restore the IPS 4240 and IPS 4255 system image, see
Installing the IPS 4240 and IPS 4255 System Image, page 13.

For the procedure for using ROMMON to restore the IPS 4260 system image, see Installing the
IPS 4260 System Image, page 16.

For the procedure for using ROMMON to restore the IPS 4270-20 system image, see Installing the
IPS 4270-20 System Image, page 18.

For the procedure for installing the ASA 5500 AIP SSM system image, see Installing the
ASA 5500 ATP SSM System Image, page 24.
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For the procedure for installing the ASA 5500-X IPS SSP system image, see Installing the
ASA 5500-X TIPS SSP System Image, page 26.

For the procedure for installing the ASA 5585-X IPS SSP system image, see Installing the ASA
5585-X IPS SSP System Image, page 27.

Upgrading the Sensor

Step 1

Step 2

~

~

Use the upgrade source-url command to apply service pack, signature update, engine update, minor
version, major version, or recovery partition file upgrades.

The following options apply:
source-url—Specifies the location of the source file to be copied:

- ftp:—Source URL for an FTP network server. The syntax for this prefix is:

ftp://[[username @ Jlocation][/relativeDirectory]/filename
ftp://[[username @ ]location][//absoluteDirectory]/filename

~

Note  You are prompted for a password.

scp:—Source URL for the SCP network server. The syntax for this prefix is:
scp://[[username @ ]Jlocation][/relativeDirectory]/filename
scp://[[username @ ]Jlocation][//absoluteDirectory]/filename

S

Note  You are prompted for a password. You must add the remote host to the SSH known hosts
list.

http:—Source URL for the web server. The syntax for this prefix is:

http://[[username @ ]Jlocation][/directory]/filename

Note The directory specification should be an absolute path to the desired file.

https:—Source URL for the web server. The syntax for this prefix is:

https://[[username @ Jlocation][/directory]/filename

Note The directory specification should be an absolute path to the desired file. The remote
host must be a TLS trusted host.

Upgrading the Sensor

To upgrade the sensor, follow these steps:

Download the appropriate file to an FTP, SCP, HTTP, or HTTPS server that is accessible from your

Log in to the CLI using an account with administrator privileges.
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Step3  Enter configuration mode.

sensor# configure terminal

Step4  Upgrade the sensor.
sensor (config) # upgrade url/IPS-SSP_10-K9-7.1-5-E4.pkg
The URL points to where the update file is located, for example, to retrieve the update using FTP, enter
the following:

sensor (config) # upgrade ftp://username@ip_address//directory/IPS-SSP_10-K9-7.1-5-E4.pkg

Step5  Enter the password when prompted.

Enter password: **xxxxxx

Step6  Enter yes to complete the upgrade.

a~

Note = Major updates, minor updates, and service packs may force a restart of the IPS processes or even
force a reboot of the sensor to complete installation.

~

Note  The operating system is reimaged and all files that have been placed on the sensor through the
service account are removed.

Step7  Verify your new sensor version.

sensor# show version
Application Partition:

Cisco Intrusion Prevention System, Version 7.1(5)E4

Host:
Realm Keys keyl.0
Signature Definition:
Signature Update 5648.0 2012-05-30
0OS Version: 2.6.29.1
Platform: IPS-4360
Serial Number: FCH1504v04T

No license present

Sensor up-time is 1 day.

Using 14379M out of 15943M bytes of available memory (90% usage)

system is using 33.6M out of 160.0M bytes of available disk space (21% usage)
application-data is using 69.2M out of 169.4M bytes of available disk space (43% usage)
boot is using 62.5M out of 70.1M bytes of available disk space (94% usage)
application-log is using 494.0M out of 513.0M bytes of available disk space (96% usage)

MainApp S-2012_JUN_01_08_40_7_1_4_87 (Release) 2012-06-01T08:44:1 8-0500
Running
AnalysisEngine S-2012_JUN_01_08_40_7_1_4_87 (Release) 2012-06-01T08:44:1 8-0500
Running
CollaborationApp S-2012_JUN_01_08_40_7_1_4_87 (Release) 2012-06-01T08:44:1 8-0500
Running
CLI S-2012_JUN_01_08_40_7_1_4_87 (Release) 2012-06-01T08:44:1 8-0500

Upgrade History:

IPS-K9-7.1-5-E4 14:00:07 UTC Fri Jun 01 2012
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Recovery Partition Version 1.1 - 7.1(5)E4
Host Certificate Vvalid from: 06-Jun-2012 to 07-Jun-2014

sensor#

For More Information
For a list of the specific IPS upgrade filenames, see IPS File List, page 2.

Reimaging the Sensor

This section describes how to reimage the sensor using the system image, and contains the following
topics:

e Installing the IPS 4240 and IPS 4255 System Image, page 13
e Installing the IPS 4260 System Image, page 16

e Installing the IPS 4270-20 System Image, page 18

e Installing the IPS 4345 and IPS 4360 System Image, page 20
¢ Installing the ASA 5500 AIP SSM System Image, page 24

¢ Installing the ASA 5500-X IPS SSP System Image, page 26
e Installing the ASA 5585-X IPS SSP System Image, page 27

Installing the IPS 4240 and IPS 4255 System Image

~

Note

Step 1

Step 2

This procedure is for the IPS 4240, but is also applicable to the IPS 4255. The system image for the
IPS 4255 has “4255” in the filename.

You can install the IPS 4240 and IPS 4255 system image by using the ROMMON on the appliance to
TFTP the system image onto the compact flash device.

To install the IPS 4240 and IPS 4255 system image, follow these steps:

Download the IPS 4240 system image file to the tftp root directory of a TFTP server that is accessible
from your IPS 4240.

>
Note = Make sure you can access the TFTP server location from the network connected to the Ethernet
port of your IPS 4240.

Boot the IPS 4240.

Booting system, please wait...

CISCO SYSTEMS
Embedded BIOS Version 1.0(5)0 09/14/04 12:23:35.90

Low Memory: 631 KB

| oL-26774-01
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Step 3

Step 4

High Memory: 2048 MB

PCI Device Table.

Bus Dev Func VendID DevID Class Irg
00 00 00 8086 2578 Host Bridge

00 01 00 8086 2579 PCI-to-PCI Bridge

00 03 00 8086 257B PCI-to-PCI Bridge

00 1c 00 8086 25AE PCI-to-PCI Bridge

00 1D 00 8086 25A9 Serial Bus 11
00 1D 01 8086 25AA Serial Bus 10
00 1D 04 8086 25AB System

00 1D 05 8086 25AC IRQ Controller

00 1D 07 8086 25AD Serial Bus 9
00 1E 00 8086 244E PCI-to-PCI Bridge

00 1F 00 8086 25A1 ISA Bridge

00 1F 02 8086 25A3 1IDE Controller 11
00 1F 03 8086 25A4 Serial Bus 5
00 1F 05 8086 25A6 Audio 5
02 01 00 8086 1075 Ethernet 11
03 01 00 177D 0003 Encrypt/Decrypt 9
03 02 00 8086 1079 Ethernet 9
03 02 01 8086 1079 Ethernet 9
03 03 00 8086 1079 Ethernet 9
03 03 01 8086 1079 Ethernet 9
04 02 00 8086 1209 Ethernet 11
04 03 00 8086 1209 Ethernet 5

Evaluating BIOS Options
Launch BIOS Extension to setup ROMMON

Cisco Systems ROMMON Version (1.0(5)0) #1: Tue Sep 14 12:20:30 PDT 2004

Platform IPS-4240-K9
Management0/0

MAC Address: 0000.cO0ff.eell

Press Break or Esc at the following prompt while the system is booting to interrupt boot. Press the

spacebar to begin boot immediately.

~

Note  You have ten seconds to press Break or Esc.

Use BREAK or ESC to interrupt boot.
Use SPACE to begin boot immediately.

The system enters ROMMON mode. The rommon> prompt appears.

Check the current network settings.

rommon> set

ROMMON Variable Settings:
ADDRESS=0.0.0.0
SERVER=0.0.0.0
GATEWAY=0.0.0.0
PORT=Management0/0
VLAN=untagged
IMAGE=
CONFIG=
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Step 5

Step 6

Step 7
Step 8

Step 9

Step 10

A

Reimaging the Sensor W

The variables have the following definitions:
e Address—Local IP address of the IPS 4240
e Server—TFTP server IP address where the application image is stored
e Gateway—Gateway IP address used by the IPS 4240
¢ Port—Fthernet interface used for the IPS 4240 management
¢ VLAN—VLAN ID number (leave as untagged)
e Image—System image file/path name

¢ Config—Unused by these platforms

Note  Not all values are required to establish network connectivity. The address, server, gateway, and
image values are required. If you are not sure of the settings needed for your local environment,
contact your system administrator.

If necessary, change the interface used for the TFTP download.

>,
Note  The default interface used for TFTP downloads is Management 0/0, which corresponds to the
MGMT interface of the IPS 4240.

rommon> PORT=interface_name

If necessary, assign an IP address for the local port on the IPS 4240.

rommon> ADDRESS=ip_ address

~

Note  Use the same IP address that is assigned to the IPS 4240.

If necessary, assign the TFTP server IP address.

rommon> SERVER=ip address

If necessary, assign the gateway IP address.

rommon> GATEWAY=ip address

Verify that you have access to the TFTP server by pinging it from your local Ethernet port with one of
the following commands.

rommon> ping server_ip_address
rommon> ping server

If necessary define the path and filename on the TFTP file server from which you are downloading the
image.

rommon> IMAGE=path/file_name

Caution

Make sure that you enter the IMAGE command in all uppercase. You can enter the other ROMMON
commands in either lower case or upper case, but the IMAGE command specifically must be all
uppercase.

| oL-26774-01
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UNIX Example

rommon> IMAGE=/system images/IPS-4240-K9-sys-1.1-a-7.0-4-E4.img

>
Note  The path is relative to the default tftpboot directory of the UNIX TFTP server. Images located

in the default tftpboot directory do not have any directory names or slashes in the IMAGE
specification.

Windows Example

rommon> IMAGE=\system images\IPS-4240-K9-sys-1.1-a-7.0-4-E4.img

Step11  Enter set and press Enter to verify the network settings.

~

Note  You can use the sync command to store these settings in NVRAM so they are maintained across
boots. Otherwise, you must enter this information each time you want to boot an image from
ROMMON.

Step12 Download and install the system image.

rommon> tftp

A

Caution  To avoid corrupting the system image, do not remove power from the IPS 4240 while the system image
is being installed.

>
Note  If the network settings are correct, the system downloads and boots the specified image on the
IPS 4240. Be sure to use the IPS 4240 image.

Installing the IPS 4260 System Image

You can install the IPS 4260 system image by using the ROMMON on the appliance to TFTP the system
image onto the flash device.

To install the IPS 4260 system image, follow these steps:

Step 1 Download the IPS 4260 system image file to the tftp root directory of a TFTP server that is accessible
from your IPS 4260.

Make sure you can access the TFTP server location from the network connected to your IPS 4260
Ethernet port.

Step2  Boot the IPS 4260.
Step3  Press Ctrl-R at the following prompt while the system is booting.

Evaluating Run Options...

Release Notes for Cisco Intrusion Prevention System 7.1(5)E4
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Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Reimaging the Sensor W

~

Note  You have five seconds to press Ctrl-R.

Assuming IPS-4260-K9 Platform
2 Ethernet Interfaces detected

Cisco Systems ROMMON Version (1.0(11)1c) #26: Mon Mar 13 18:05:54 CST 2006

Platform IPS-4260-K9
Management0/0

Link is UP

MAC Address: 0004.23cc.6047

Use ? for help.

rommon #0>

If necessary, change the port used for the TFTP download.
rommon #1> interface name

The port in use is listed just after the platform identification. In the example, port Management 0/0 is
being used.

>
Note  The default port used for TFTP downloads is Management 0/0, which corresponds with the
command and control (MGMT) interface of the IPS 4260.

S,
Note  Ports Management 0/0 (MGMT) and GigabitEthernet 0/1 (GE 0/1) are labeled on the back of the
chassis.

Specify an IP address for the local port on the IPS 4260.

rommon> address ip_ address

~

Note  Use the same IP address that is assigned to the IPS 4260.

Specify the TFTP server IP address.

rommon> server ip_address

Specify the gateway IP address.

rommon> gateway ip_address

Verify that you have access to the TFTP server by pinging it from the local Ethernet port.

rommon> ping server_ip_address
rommon> ping server

Specify the path and filename on the TFTP file server from which you are downloading the image.

rommon> file path/filename

UNIX Example

rommon> file /system_images/IPS-4260-K9-sys-1.1-a-7.0-4-E4.img
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Step 10

~

Note The path is relative to the default tftpboot directory of the UNIX TFTP server. Images located
in the default tftpboot directory do not have any directory names or slashes in the file location.

Windows Example

rommon> file <tftpboot_directory>IPS-4260-K9-sys-1.1-a-7.0-4-E4.img

Download and install the system image.

rommon> tftp

~

Note The IPS 4260 reboots once during the reimaging process. Do not remove power from the
IPS 4260 during the update process or the upgrade can become corrupted.

Installing the IPS 4270-20 System Image

Step 1

Step 2

Step 3

You can install the IPS 4270-20 system image by using the ROMMON on the appliance to TFTP the
system image onto the compact flash device.

To install the IPS 4270-20 system image, follow these steps:

Download the IPS 4270-20 system image file to the tftp root directory of a TFTP server that is accessible
from your IPS 4270-20.

~

Note = Make sure you can access the TFTP server location from the network connected to the Ethernet
port of your IPS 4270-20.

Boot the IPS 4270-20.

Booting system, please wait...
Cisco Systems ROMMON Version (1.0(12)10) #7: Thu Jun 21 13:50:04 CDT 2007

ft_id_update: Invalid ID-PROM Controller Type (0x5df)

ft_id_update: Defaulting to Controller Type (0x5c2)

~

Note  The controller type errors are a known issue and can be disregarded.

Press Break or Esc at the following prompt while the system is booting to interrupt boot. Press the
spacebar to begin boot immediately.

~

Note  You have ten seconds to press Break or Esc.

Use BREAK or ESC to interrupt boot.
Use SPACE to begin boot immediately.

The system enters ROMMON mode. The rommon> prompt appears.

Release Notes for Cisco Intrusion Prevention System 7.1(5)E4
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Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Reimaging the Sensor W

Check the current network settings.
rommon> set
ROMMON Variable Settings:
ADDRESS=0.0.0.0
SERVER=0.0.0.0
GATEWAY=0.0.0.0
PORT=Management0/0
VLAN=untagged
IMAGE=
CONFIG=
LINKTIMEOUT=20

PKTTIMEOUT=2
RETRY=20

The variables have the following definitions:
e Address—Specifies the local IP address of the IPS 4270-20.
e Server—Specifies the TFTP server IP address where the application image is stored.
e Gateway—Specifies the gateway IP address used by the IPS 4270-20.
e Port—Specifies the Ethernet interface used for IPS 4270-20 management.
e VLAN—Specifies the VLAN ID number (leave as untagged).
e Image—Specifies the system image file/path name.
e Config—Unused by these platforms.

S

Note  Not all values are required to establish network connectivity. The address, server, gateway,
and image values are required. If you are not sure of the settings needed for your local
environment, contact your system administrator.

If necessary, assign an IP address for the local port on the IPS 4270-20.

rommon> ADDRESS=ip address

~

Note  Use the same IP address that is assigned to the IPS 4270-20.

If necessary, assign the TFTP server IP address.

rommon> SERVER=ip_address

If necessary, assign the gateway IP address.

rommon> GATEWAY=ip address

Verify that you have access to the TFTP server by pinging it from your local Ethernet port with one of
the following commands:

rommon> ping server_ip_address

rommon> ping server

If necessary define the path and filename on the TFTP file server from which you are downloading the
image.

rommon> IMAGE=path/file_name

| oL-26774-01
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UNIX Example

rommon> IMAGE=/system images/IPS-4270_20-K9-sys-l1l.1-a-7.1-5-E4.img

>
Note  The path is relative to the UNIX TFTP server default tftpboot directory. Images located in the

default tftpboot directory do not have any directory names or slashes in the IMAGE
specification.

Windows Example

rommon> IMAGE=\system images\IPS-4270_20-K9-sys-l1l.1-a-7.1-5-E4.img

Step10  Enter set and press Enter to verify the network settings.

~

Note  You can use the sync command to store these settings in NVRAM so they are maintained across
boots. Otherwise, you must enter this information each time you want to boot an image from
ROMMON.

Step11 Download and install the system image.

rommon> tftp

A

Caution  To avoid corrupting the system image, do not remove power from the IPS 4270-20 while the system
image is being installed.

~
Note If the network settings are correct, the system downloads and boots the specified image on the
IPS 4270-20. Be sure to use the IPS 4270-20 image.

For More Information

e For the procedure for locating software, see Obtaining Software, page 8.
e For a list of supported TFTP servers, see Supported Servers, page 4.
e For a list of the specific IPS software files, see IPS File List, page 2.

e For the procedure for initializing the sensor with the setup command, see Initializing the Sensor,
page 37.

Installing the IPS 4345 and IPS 4360 System Image

You can install the IPS 4345 and IPS 4360 system image by using the ROMMON on the appliance to
TFTP the system image on to the compact flash device.

S,
Note  This procedure is for IPS 4345, but is also applicable to IPS 4360. The system image for IPS 4360 has
“4360” in the filename.
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Step 1

Step 2

Step 3

Reimaging the Sensor W

To install the IPS 4345 and IPS 4360 system image, follow these steps:

Download the IPS 4345 system image file to the tftp root directory of a TFTP server that is accessible
from your IPS 4345.

>
Note = Make sure you can access the TFTP server location from the network connected to the Ethernet
port of your IPS 4345.

Boot the IPS 4345.

Booting system, please wait...

CISCO SYSTEMS
Embedded BIOS Version 1.0(5)0 09/14/04 12:23:35.90

Low Memory: 631 KB

High Memory: 2048 MB

PCI Device Table.

Bus Dev Func VendID DevID Class Irqg
00 00 00 8086 2578 Host Bridge

00 01 00 8086 2579 PCI-to-PCI Bridge

00 03 00 8086 257B PCI-to-PCI Bridge

00 1c 00 8086 25AE PCI-to-PCI Bridge

00 1D 00 8086 25A9 Serial Bus 11
00 1D 01 8086 25AA Serial Bus 10
00 1D 04 8086 25AB System

00 1D 05 8086 25AC 1IRQ Controller

00 1D 07 8086 25AD Serial Bus 9
00 1E 00 8086 244E PCI-to-PCI Bridge

00 1F 00 8086 25A1 ISA Bridge

00 1F 02 8086 25A3 IDE Controller 11
00 1F 03 8086 25A4 Serial Bus 5
00 1F 05 8086 25A6 Audio 5
02 01 00 8086 1075 Ethernet 11
03 01 00 177D 0003 Encrypt/Decrypt 9
03 02 00 8086 1079 Ethernet 9
03 02 01 8086 1079 Ethernet 9
03 03 00 8086 1079 Ethernet 9
03 03 01 8086 1079 Ethernet 9
04 02 00 8086 1209 Ethernet 11
04 03 00 8086 1209 Ethernet 5

Evaluating BIOS Options ...
Launch BIOS Extension to setup ROMMON

Cisco Systems ROMMON Version (1.0(5)0) #1: Tue Sep 14 12:20:30 PDT 2004

Platform IPS-4345-K9
Management0/0

MAC Address: 0000.cO0ff.eell

Press Break or Esc at the following prompt while the system is booting to interrupt boot. Press the
spacebar to begin boot immediately.

~

Note  You have ten seconds to press Break or Esc.

Use BREAK or ESC to interrupt boot.
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Step 4

Step 5

Step 6

Step 7

Step 8

Use SPACE to begin boot immediately.

The system enters ROMMON mode. The rommon> prompt appears.

Check the current network settings.

rommon> set

ROMMON Variable Settings:
ADDRESS=0.0.0.0
SERVER=0.0.0.0
GATEWAY=0.0.0.0
PORT=Management0/0
VLAN=untagged
IMAGE=
CONFIG=

The variables have the following definitions:
e Address—Local IP address of the IPS 4345.
e Server—TFTP server IP address where the application image is stored.
e Gateway—Gateway IP address used by the IPS 4345.
e Port—Ethernet interface used for the IPS 4345 management.
e VLAN—VLAN ID number (leave as untagged).
e Image—System image file/path name.

¢ Config—Unused by these platforms.

~

Note  Not all values are required to establish network connectivity. The address, server, gateway,
and image values are required. If you are not sure of the settings needed for your local
environment, contact your system administrator.

If necessary, change the interface used for the TFTP download.

~

Note  The default interface used for TFTP downloads is Management 0/0, which corresponds to the
MGMT interface of the IPS 4345.

rommon> PORT=interface_name

If necessary, assign an IP address for the local port on the IPS 4345.

rommon> ADDRESS=ip_ address

~

Note  Use the same IP address that is assigned to the IPS 4345.

Assign the TFTP server IP address.

rommon> SERVER=ip address

If necessary, assign the gateway IP address.

rommon> GATEWAY=ip address

Release Notes for Cisco Intrusion Prevention System 7.1(5)E4
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Step 9

Step 10

A

Reimaging the Sensor W

Verify that you have access to the TFTP server by pinging it from your local Ethernet port with one of
the following commands:

rommon> ping server_ip_address

rommon> ping server

If necessary define the path and filename on the TFTP file server from which you are downloading the
image.

rommon> IMAGE=path file_name

Caution

Step 11

Step 12

Make sure that you enter the IMAGE command in all uppercase. You can enter the other ROMMON
commands in either lower case or upper case, but the IMAGE command specifically must be all
uppercase.

UNIX Example

rommon> IMAGE=system_images IPS-4345-K9-sys-1.1-a-7.1-5-E4.img

>
Note  The path is relative to the default tftpboot directory of the UNIX TFTP server. Images located

in the default tftpboot directory do not have any directory names or slashes in the IMAGE
specification.

Windows Example

rommon> IMAGE=system_images IPS-4345-K9-sys-1.1-a-7.1-5-E4.img

Enter set and press Enter to verify the network settings.

~

Note  You can use the sync command to store these settings in NVRAM so they are maintained across
boots. Otherwise, you must enter this information each time you want to boot an image from
ROMMON.

Download and install the system image.

rommon> tftp

Caution

To avoid corrupting the system image, do not remove power from the IPS 4345 while the system image
is being installed.

S
Note  If the network settings are correct, the system downloads and boots the specified image on the
IPS 4345. Be sure to use the IPS 4345 image.

For More Information

¢ For the procedure for locating software, see Obtaining Software, page 8.

e For a list of supported TFTP servers, see Supported Servers, page 4.
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e For a list of the specific IPS software files, see IPS File List, page 2.

e For the procedure for initializing the sensor with the setup command, see Initializing the Sensor,
page 37.

Installing the ASA 5500 AIP SSM System Image

Step 1

Step 2
Step 3

Step 4

Step 5

Step 6

Be sure the TFTP server that you specify can transfer files up to 60 MB in size.

This process can take approximately 15 minutes to complete, depending on your network and the size
of the image.

If the ASA 5500 AIP SSM suffers a failure and the module application image cannot run, you can
transfer application images from a TFTP server to the module using the adaptive security appliance CLI.
The adaptive security appliance can communicate with the module ROMMON application to transfer the
image.

To install the system image of the ASA 5500 AIP SSM, follow these steps:

Download the system image file to the tftp root directory of a TFTP server that is accessible from your
adaptive security appliance.

~

Note = Make sure you can access the TFTP server location from the network connected to the Ethernet
port of the adaptive security appliance.

Log in to the adaptive security appliance.
Enter enable mode.

asa# enable

Configure the recovery settings for the ASA 5500 AIP SSM.

asa (enable)# hw-module module 1 recover configure

~

Note If you make an error in the recovery configuration, use the hw-module module 1 recover stop
command to stop the system reimaging and then you can correct the configuration.

Specify the TFTP URL for the system image.

Image URL [tftp://0.0.0.0/1:

Example

Image URL [tftp://0.0.0.0/]1: tftp://192.0.2.0/IPS-SSP-K9-sys-1.1-a-7.1-2-E4.img
Specify the command and control interface of the ASA 5500 AIP SSM.

a~

Note  The port IP address is the management IP address of the ASA 5500 AIP SSM.
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Step 7

Step 8

Step 9

Step 10

Port IP Address [0.0.0.0]:

Example

Port IP Address [0.0.0.0]: 10.89.149.231

Leave the VLAN ID at 0.

VLAN ID [0]:

Specify the default gateway of the ASA 5500 AIP SSM.

Gateway IP Address [0.0.0.0]:

Example

Gateway IP Address [0.0.0.0]: 10.89.149.254

Execute the recovery.

asa# hw-module module 1 recover boot

Reimaging the Sensor W

This transfers the image from the TFTP server to the ASA 5500 AIP SSM.

Periodically check the recovery until it is complete.

~

Note  The status reads Recovery during recovery and reads up when reimaging is complete.

asa# show module 1

ASA5540
ASA-SSM-20

Fw Version

1.0(7)2
1.0(7)2

Serial No.

P2B00000019
P1D000004F4

Sw Version

7.1(1)82
5.0(0.22)8129.0

Mod Card Type
0 ASA 5540 Adaptive Security Appliance
1 ASA 5500 Series Security Services Module-20
Mod MAC Address Range Hw Version
0 000b.fcf8.7blc to 000b.fcf8.7b20 0.2
1 000b.fcf8.01le to 000b.fcf8.01lle 0.1
Mod Status
0 Up Sys
1 Up
asa#

Note  The Status field in the output indicates the operational status of the ASA 5500 AIP SSM. An
ASA 5500 AIP SSM operating normally shows a status of “Up.” While the adaptive security
appliance transfers an application image to the ASA 5500 AIP SSM, the Status field in the
output reads “Recover.” When the adaptive security appliance completes the image transfer and
restarts the ASA 5500 AIP SSM, the newly transferred image is running.

Note  To debug any errors that may happen in the recovery process, use the debug module-boot

command to enable debugging of the system reimaging process.
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Step 11

Session to the ASA 5500 AIP SSM and initialize it with the setup command.

Installing the ASA 5500-X IPS SSP System Image

S

Note

Step 1

Step 2
Step 3

Step 4

Step 5

Step 6

Step 7

Be sure the TFTP server that you specify can transfer files up to 60 MB in size.

To install the system image on the ASA 5500-X IPS SSP, follow these steps:

Download the IPS system image file corresponding to your ASA platform to the tftp root directory of a
TFTP server that is accessible from your adaptive security appliance.

a~

Note  Make sure you can access the TFTP server location from the network connected to the Ethernet
port of the adaptive security appliance.

Log in to the adaptive security appliance.
Enter enable mode.

asa> enable

Copy the IPS image to the diskO flash of the adaptive security appliance.

asa# copy tftp://192.0.2.0/directory/IPS-5545-K9-sys-1.1-a-7.1-5-E4.aip diskO:

Image the ASA 5500-X IPS SSP.

asa# sw-module module ips recover configure image
diskO:/IPS-SSP_5545-K9-sys-1.1-a-7.1-5-E4.aip

Execute the recovery. This transfers the image from the TFTP server to the ASA 5500-X IPS SSP and
restarts it.

asa# sw-module module ips recover boot

Periodically check the recovery until it is complete.

asa# show module

Mod Card Type Model Serial No.
0 Cisco ASA 5545 Appliance with 8 GE ports, 1 ASA5545 ABC1234D56E
1 IPS 5545 Intrusion Protection System IPS5545 ABC1234D56E

Mod MAC Address Range Hw Version Fw Version Sw Version

0 503d.e59c.6dcl to 503d.e59c.6dca 1.0 8.6.1

ips 503d.e59c.6dcb to 503d.e59c.6dcb N/A N/A 7.1(5)E4

Mod SSM Application Name Status SSM Application Version
1 IPS Up 7.1(5)E4
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Mod Status Data Plane Status Compatibility
0 Up Sys Not Applicable
1 Up Up

asa#

Note  The Status field in the output indicates the operational status of the ASA 5500-X IPS SSP. An
ASA 5500-X IPS SSP operating normally shows a status of “Up.” While the adaptive security
appliance transfers an application image to the ASA 5500-X IPS SSP, the Status field in the
output reads “Recover.” When the adaptive security appliance completes the image transfer and
restarts the ASA 5500-X IPS SSP, the newly transferred image is running.

Note  To debug any errors that may happen in the recovery process, use the debug module-boot
command to enable debugging of the system reimaging process.

Step8  Session to the ASA 5500-X IPS SSP and initialize it with the setup command.

For More Information
e For the procedure for locating software, see Obtaining Software, page 8.

e For a list of supported TFTP servers, see Supported Servers, page 4.
e For a list of the specific IPS software files, see IPS File List, page 2.

e For the procedure for initializing the sensor with the setup command, see Initializing the Sensor,
page 37.

Installing the ASA 5585-X IPS SSP System Image

This section describes how to install the ASA 5585-X IPS SSP system image using the hw-module
command or ROMMON, and contains the following topics:

¢ Using the hw-module Command, page 27
e Using ROMMON, page 30

Using the hw-module Command

To install the system image, transfer the software image from a TFTP server to the ASA 5585-X IPS SSP
using the adaptive security appliance CLI. The adaptive security appliance can communicate with the
ROMMON application of the ASA 5585-X IPS SSP to transfer the image.

Note  Be sure the TFTP server that you specify can transfer files up to 60 MB in size.

Note  This process can take approximately 15 minutes to complete, depending on your network and the size
of the image.

Release Notes for Cisco Intrusion Prevention System 7.1(5)E4
| oL-26774-01 .m



Bl Reimaging the Sensor

To install the ASA 5585-X IPS SSP software image, follow these steps:

Step 1 Download the ASA 5585-X TIPS SSP system image file to the tftp root directory of a TFTP server that is
accessible from your adaptive security appliance.

~

Note = Make sure you can access the TFTP server location from the network connected to the Ethernet
port of your adaptive security appliance.

Step2 Log in to the adaptive security appliance.
Step3  Enter enable mode.

asa# enable

Step4  Configure the recovery settings for the ASA 5585-X IPS SSP.

asa (enable)# hw-module module 1 recover configure

~

Note If you make an error in the recovery configuration, use the hw-module module 1 recover stop
command to stop the system reimaging and then you can correct the configuration.

Step5  Specify the TFTP URL for the software image.

Image URL [tftp://0.0.0.0/1:

Example

Image URL [tftp://0.0.0.0/]: tftp://192.0.2.0/IPS-SSP_40-K9-sys-1.1-a-7.1-5-E4.img

Step6  Specify the command and control interface of the ASA 5585-X IPS SSP.

~

Note  The port IP address is the management IP address of the ASA 5585-X IPS SSP.

Port IP Address [0.0.0.0]:

Example

Port IP Address [0.0.0.0]: 10.89.149.231

Step7 Leave the VLAN ID at 0.

VLAN ID [0]:

Step8  Specify the default gateway of the ASA 5585-X IPS SSP.

Gateway IP Address [0.0.0.0]:

Example

Gateway IP Address [0.0.0.0]: 10.89.149.254

Step9  Execute the recovery. This transfers the software image from the TFTP server to the
ASA 5585-X IPS SSP and restarts it.

asa# hw-module module 1 recover boot

Step10 Periodically check the recovery until it is complete.
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Step 11
Step 12
Step 13

~

Note

Reimaging the Sensor W

The status reads Recovery during recovery and reads up when installation is complete.

asa# show module 1 details

Getting details from the Service Module,

please wait...

ASA 5585-X IPS Security Services Processor-10 with 8GE

Model: ASA5585-SSP-IPS40
Hardware version: 1.0

Serial Number: JAF1350ABSL
Firmware version: 2.0(1)3

Software version: 7.1(5)E4

MAC Address Range: 8843.el2f.5414 to 8843.el2f.541f
App. name: IPS

App. Status: Up

App. Status Desc: Normal Operation

App. version: 7.1(5)E4

Data plane Status: Up

Status: Up

Mgmt IP addr: 192.0.2.0

Mgmt Network mask: 255.255.255.0

Mgmt Gateway: 10.89.148.254

Mgmt Access List: 10.0.0.0/8

Mgmt Access List: 64.0.0.0/8

Mgmt web ports: 443

Mgmt TLS enabled true

asa#

)

Note  The Status field in the output indicates the operational status of the ASA 5585-X IPS SSP. An

ASA 5585-X IPS SSP operating normally shows a status of “Up.” While the adaptive security
appliance transfers the software image to the ASA 5585-X IPS SSP, the Status field in the output
reads “Recover.” When the adaptive security appliance completes the software image transfer
and restarts the ASA 5585-X IPS SSP, the newly transferred image is running.

S

Note

To debug any errors that may happen during this process, use the debug module-boot command
to enable debugging of the software installation process.

Session to the ASA 5585-X IPS SSP.
Enter cisco three times and your new password twice.

Initialize the ASA 5585-X IPS SSP with the setup command.

For More Information
e For the procedure for locating software, see Obtaining Software, page 8.

e For a list of supported TFTP servers, see Supported Servers, page 4.
e For a list of the specific IPS software files, see IPS File List, page 2.

e For the procedure for initializing the sensor with the setup command, see Initializing the Sensor,
page 37.
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Using ROMMON

Step 1

Step 2

Step 3

Step 4

You can install the ASA 5585-X IPS SSP system image by using the ROMMON on the adaptive security
appliance to TFTP the system image onto the ASA 5585-X IPS SSP.

To install the ASA 5585-X IPS SSP system image, follow these steps:

Download the ASA 5585-X TIPS SSP system image file to the tftp root directory of a TFTP server that is
accessible from your adaptive security appliance.

S

Note = Make sure you can access the TFTP server location from the network connected to the Ethernet
port of your adaptive security appliance.

Boot the ASA 5585-X IPS SSP.

Booting system, please wait...

CISCO SYSTEMS

Embedded BIOS Version 0.0(2)10 11:16:38 04/15/10

Com KbdBuf SMM UsbHid Msg0O Prompt Pmrt Cachel LowM ExtM HugeM Cache2 Flg Siz0 Amrt PMM
PnpDsp Smbios Lpt0 Npxl Apm Lpl Acpi Typ Dbg Enb Mp MemReduce MemSyncl CallRoms MemSync?2
Drivelnit

Total memory : 12 GB

Total number of CPU cores : 8

Com Lpl Admgr2 Brdl0 Plx2 OEMO=7EFF5C74

Cisco Systems ROMMON Version (1.0(12)10) #0: Thu Apr 8 00:12:33 CDT 2010

Use BREAK or ESC to interrupt boot.
Use SPACE to begin boot immediately.
Boot interrupted.

Management0/0
Link is UP
MAC Address: 5475.d029.7fa9

Press Break or Esc at the following prompt while the system is booting to interrupt boot. Press the
spacebar to begin boot immediately.

~

Note  You have ten seconds to press Break or Esc.

Use BREAK or ESC to interrupt boot.
Use SPACE to begin boot immediately.

The system enters ROMMON mode. The rommon> prompt appears.

Check the current network settings.

rommon #0> set

ROMMON Variable Settings:
ADDRESS=0.0.0.0
SERVER=0.0.0.0
GATEWAY=0.0.0.0
PORT=Management0/0
VLAN=untagged
IMAGE=
CONFIG=
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Step 5

Step 6

Step 7

Step 8

Step 9

Step 10

Reimaging the Sensor W

LINKTIMEOUT=20
PKTTIMEOUT=4
RETRY=20

The variables have the following definitions:
e Address—Specifies the local IP address of the ASA 5585-X IPS SSP.
e Server—Specifies the TFTP server IP address where the application image is stored.
e Gateway—Specifies the gateway IP address used by the ASA 5585-X IPS SSP.
e Port—Specifies the ethernet interface used for the ASA 5585-X IPS SSP management.
e VLAN—Specifies the VLAN ID number (leave as untagged).
e Image—Specifies the system image file/path name.
e Config—Specifies the unused by these platforms.

~

Note  Not all values are required to establish network connectivity. The address, server, gateway,
and image values are required. If you are not sure of the settings needed for your local
environment, contact your system administrator.

If necessary, change the interface used for the TFTP download.

>
Note  The default interface used for TFTP downloads is Management 0/0, which corresponds to the
management interface of the ASA 5585-X IPS SSP.

rommon> PORT=interface_name

If necessary, assign an IP address for the local port on the ASA 5585-X IPS SSP.

rommon> ADDRESS=ip_ address

~

Note  Use the same IP address that is assigned to the ASA 5585-X IPS SSP.

If necessary, assign the TFTP server IP address.

rommon> SERVER=ip address

If necessary, assign the gateway IP address.

rommon> GATEWAY=ip_ address

Verify that you have access to the TFTP server by pinging it from your local Ethernet port with one of
the following commands.

rommon> ping server_ip_address

rommon> ping server

If necessary define the path and filename on the TFTP file server from which you are downloading the
image.

rommon> IMAGE=path/file_name

| oL-26774-01
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A

Caution = Make sure that you enter the IMAGE command in all uppercase. You can enter the other ROMMON
commands in either lower case or upper case, but the IMAGE command specifically must be all
uppercase.

UNIX Example

rommon> IMAGE=/system images/IPS-SSP_10-K9-sys-1.1-a-7.1-5-E4.img

a~

Note  The path is relative to the default tftpboot directory of the UNIX TFTP server. Images located
in the default tftpboot directory do not have any directory names or slashes in the IMAGE
specification.

Windows Example

rommon> IMAGE=\system images\IPS-SSP_10-K9-sys-1.1l-a-7.1-5-E4.img

Step11  Enter set and press Enter to verify the network settings.

~

Note  You can use the sync command to store these settings in NVRAM so they are maintained across
boots. Otherwise, you must enter this information each time you want to boot an image from
ROMMON.

Step12 Download and install the system image.

rommon> tftp

~

Note  If the network settings are correct, the system downloads and boots the specified image on the
ASA 5585-X IPS SSP. Be sure to use the ASA 5585-X IPS SSP image.

A

Caution  To avoid corrupting the system image, do not remove power from the ASA 5585-X IPS SSP while the
system image is being installed.

For More Information

e For the procedure for locating software, see Obtaining Software, page 8.
e For a list of supported TFTP servers, see Supported Servers, page 4.
e For a list of the specific IPS software files, see IPS File List, page 2.

e For the procedure for initializing the sensor with the setup command, see Initializing the Sensor,
page 37.
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Licensing the Sensor

You can install the license key through the CLI, IDM, or IME. This section describes how to obtain and
install the license key, and contains the following topics:

e Using the IDM or IME, page 33

e Using the CLI, page 34

e Obtaining a New License for the IPS 4270-20, page 36
e Licensing the ASA 5500-X IPS SSP, page 37

Using the IDM or IME
~

Note  In addition to a valid Cisco.com username and password, you must also have a Cisco Services for IPS
service contract before you can apply for a license key.

To obtain and install the license key, follow these steps:

Step 1 Log in to the IDM or the IME using an account with administrator privileges.

Step 2 For the IDM choose Configuration > Sensor Management > Licensing. For the IME choose
Configuration > sensor_name > Sensor Management > Licensing.

Step3  The Licensing pane displays the status of the current license. If you have already installed your license,
you can click Download to save it if needed.

Step4  Obtain a license key by doing one of the following:

¢ (Click the Cisco.com radio button to obtain the license from Cisco.com. The IDM or the IME
contacts the license server on Cisco.com and sends the server the serial number to obtain the license
key. This is the default method. Go to Step 5.

e Click the License File radio button to use a license file. To use this option, you must apply for a
license key at this URL: www.cisco.com/go/license. The license key is sent to you in e-mail and you
save it to a drive that the IDM or the IME can access. This option is useful if your computer cannot
access Cisco.com. Go to Step 7.

Step5  Click Update License, and in the Licensing dialog box, click Yes to continue. The Status dialog box
informs you that the sensor is trying to connect to Cisco.com. An Information dialog box confirms that
the license key has been updated.

Step6  Click OK.

Step7 Login to Cisco.com.

Step8  Go to www.cisco.com/go/license.

Step9  Fill in the required fields. Your license key will be sent to the e-mail address you specified.

A

Caution  You must have the correct IPS device serial number and product identifier (PID) because the license key
only functions on the device with that number.

Step10  Save the license key to a hard-disk drive or a network drive that the client running the IDM or the IME
can access.
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Step 11
Step 12

Step 13
Step 14
Step 15
Step 16

Using the CLI
N~

Note

Log in to the IDM or the IME.

For the IDM choose Configuration > Sensor Management > Licensing. For the IME choose
Configuration > sensor_name > Sensor Management > Licensing.

Under Update License, click the License File radio button.

In the Local File Path field, specify the path to the license file or click Browse Local to browse to the file.

Browse to the license file and click Open.

Click Update License.

You cannot install an older license key over a newer license key.

Use the copy source-url license_file_name license-key command to copy the license key to your sensor.
The following options apply:

e source-url—The location of the source file to be copied. It can be a URL or keyword.

e destination-url—The location of the destination file to be copied. It can be a URL or a keyword.

¢ license-key—The subscription license file.

e license_file_name—The name of the license file you receive.

The exact format of the source and destination URLs varies according to the file. Here are the valid
types:
e ftp:—Source URL for an FTP network server. The syntax for this prefix is:

ftp://[[username @ ]Jlocation][/relativeDirectory]/filename

ftp://[[username @ ]location][//absoluteDirectory]/filename

~

Note  You are prompted for a password.

e scp:—Source URL for the SCP network server. The syntax for this prefix is:
scp://[[username @ ]Jlocation][/relativeDirectory]/filename

scp://[[username @ ]Jlocation][//absoluteDirectory]/filename

~

Note  You are prompted for a password. You must add the remote host to the SSH known hosts list.

¢ http:—Source URL for the web server. The syntax for this prefix is:

http://[[username @ ]Jlocation][/directory]/filename

~

Note The directory specification should be an absolute path to the desired file.
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Step 3

Step 4
Step 5
Step 6

Step 7

Licensing the Sensor 1l

e https:—Source URL for the web server. The syntax for this prefix is:
https://[[username @ Jlocation][/directory]/filename

S

Note The directory specification should be an absolute path to the desired file. The remote host
must be a TLS trusted host.

Installing the License Key

To install the license key, follow these steps:

Log in to Cisco.com.
Apply for the license key at this URL: www.cisco.com/go/license.

~

Note In addition to a valid Cisco.com username and password, you must also have a Cisco Services
for IPS service contract before you can apply for a license key.

Fill in the required fields. Your Cisco IPS Signature Subscription Service license key will be sent by
email to the e-mail address you specified.

S

Note  You must have the correct IPS device serial number and product identifier (PID) because the
license key only functions on the device with that number.

Save the license key to a system that has a Web server, FTP server, or SCP server.
Log in to the CLI using an account with administrator privileges.

Copy the license key to the sensor.

sensor# copy scp://user@192.168.1.2/24://tftpboot/dev.lic license-key
Password: *#*#*&kk*

Verify the sensor is licensed.

sensor# show version
Application Partition:

Cisco Intrusion Prevention System, Version 7.1(5)E4

Host:
Realm Keys keyl.0
Signature Definition:
Signature Update 5648.0 2012-05-30
0OS Version: 2.6.29.1
Platform: IPS-4360
Serial Number: FCH1504v04T

No license present

Sensor up-time is 1 day.

Using 14379M out of 15943M bytes of available memory (90% usage)

system is using 33.6M out of 160.0M bytes of available disk space (21% usage)
application-data is using 69.2M out of 169.4M bytes of available disk space (43% usage)
boot is using 62.5M out of 70.1M bytes of available disk space (94% usage)
application-log is using 494.0M out of 513.0M bytes of available disk space (96% usage)

MainApp S-2012_JUN_01_08_40_7_1_4_87 (Release) 2012-06-01T08:44:1 8-0500
Running
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AnalysisEngine S-2012_JUN_01_08_40_7_1_4_87 (Release) 2012-06-01T08:44:1 8-0500
Running
CollaborationApp S-2012_JUN_01_08_40_7_1_4_87 (Release) 2012-06-01T08:44:1 8-0500
Running
CLI S-2012_JUN_01_08_40_7_1_4_87 (Release) 2012-06-01T08:44:1 8-0500

Upgrade History:

IPS-K9-7.1-5-E4 14:00:07 UTC Fri Jun 01 2012
Recovery Partition Version 1.1 - 7.1(5)E4
Host Certificate valid from: 06-Jun-2012 to 07-Jun-2014

sensor#

Obtaining a New License for the IPS 4270-20

Step 1
Step 2
Step 3
Step 4

Step 5

A

If your IPS 4270-20 has a license that was generated for IPS 6.0.x versions or earlier, you need to get a
new license.

To obtain a new license for your IPS 4270-20, follow these steps:

Log in to Cisco.com.
Go to www.cisco.com/go/license.
Under Licenses Not Requiring a PAK, click Demo and Evaluation licenses.

Under Security Products/Cisco Services for IPS service license (Version 6.1 and later), click All IPS
Hardware Platforms.

Fill in the required fields. Your license key will be sent to the email address you specified.

Caution

Step 6

Step 7
Step 8

Step 9

Step 10
Step 11
Step 12

You must have the correct IPS device serial number and product identifier (PID) because the license key
only functions on the device with that number.

Save the license key to a hard-disk drive or a network drive that the client running the IDM or the IME
can access.

Log in to the IDM or the IME.

For the IDM choose Configuration > Sensor Management > Licensing. For the IME choose
Configuration > sensor_name > Sensor Management > Licensing.

Under Update License, click the License File radio button.

In the Local File Path field, specify the path to the license file or click Browse Local to browse to the file.

Browse to the license file and click Open.

Click Update License.
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Licensing the ASA 5500-X IPS SSP

For the ASA 5500-X series adaptive security appliances with the IPS SSP, the ASA requires the IPS
Module license. To view your current ASA licenses, in ASDM choose Home > Device Dashboard >
Device Information > Device License. For more information about ASA licenses, refer to the licensing
chapter in the configuration guide. After you obtain the ASA IPS Module license, you can obtain and
install the IPS license key.

For More Information

e For more information about getting started using the ASA 5500-X IPS SSP, refer to the Cisco IPS
Module on the ASA Quick Start Guide.

e For the procedures for obtaining and installing the IPS License key, see Licensing the Sensor,
page 33.

Initializing the Sensor

This section describes how to initialize the sensor using the setup command, and contains the following
sections:

e Understanding Initialization, page 37

e Simplified Setup Mode, page 38

e System Configuration Dialog, page 38

e Basic Sensor Setup, page 40

e Advanced Setup for the IPS Appliance, page 43

e Advanced Setup for the ASA 5500 AIP SSM, page 48
e Advanced Setup for the ASA 5500-X IPS SSP, page 52
e Advanced Setup for the ASA 5585-X IPS SSP, page 55
e Verifying Initialization, page 59

Understanding Initialization
~

Note  You must be administrator to use the setup command.

After you install the sensor on your network, you must use the setup command to initialize it so that you
can communicate with it over the network. You cannot use the IDM or the IME to configure the sensor
until you initialize the sensor using the setup command.

With the setup command, you configure basic sensor settings, including the hostname, IP interfaces,
access control lists, global correlation servers, and time settings. You can continue using advanced setup
in the CLI to enable Telnet, configure the web server, and assign and enable virtual sensors and
interfaces, or you can use the Startup Wizard in the IDM or the IME. After you configure the sensor with
the setup command, you can change the network settings in the IDM or the IME.
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A

Caution

You must have a valid sensor license for global correlation features to function. You can still configure
and display statistics for the global correlation features, but the global correlation databases are cleared
and no updates are attempted. Once you install a valid license, the global correlation features are
reactivated.

Simplified Setup Mode

The sensor automatically calls the setup command when you connect to the sensor using a console cable
and the sensor basic network settings have not yet been configured. The sensor does not call automatic
setup under the following conditions:

e When initialization has already been successfully completed.
e If you have recovered or downgraded the sensor.

e If you have set the host configuration to default after successfully configuring the sensor using
automatic setup.

When you enter the setup command, an interactive dialog called the System Configuration Dialog
appears on the system console screen. The System Configuration Dialog guides you through the
configuration process. The values shown in brackets next to each prompt are the default values last set.

System Configuration Dialog

Note

When you enter the setup command, an interactive dialog called the System Configuration Dialog
appears on the system console screen. The System Configuration Dialog guides you through the
configuration process. The values shown in brackets next to each prompt are the current values.

You must go through the entire System Configuration Dialog until you come to the option that you want
to change. To accept default settings for items that you do not want to change, press Enter.

To return to the EXEC prompt without making changes and without going through the entire System
Configuration Dialog, press Ctrl-C. The System Configuration Dialog also provides help text for each
prompt. To access the help text, enter 2 at a prompt.

When you complete your changes, the System Configuration Dialog shows you the configuration that
you created during the setup session. It also asks you if you want to use this configuration. If you enter
ves, the configuration is saved. If you enter no, the configuration is not saved and the process begins
again. There is no default for this prompt; you must enter either yes or no.

You can configure daylight savings time either in recurring mode or date mode. If you choose recurring
mode, the start and end days are based on week, day, month, and time. If you choose date mode, the start
and end days are based on month, day, year, and time. Choosing disable turns off daylight savings time.

You only need to set the date and time in the System Configuration Dialog if the system is an appliance
and is NOT using NTP.

The System Configuration Dialog is an interactive dialog. The default settings are displayed.
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Example 1 shows a sample System Configuration Dialog.

Example 1 Example System Configuration Dialog
--- Basic Setup ---

--- System Configuration Dialog ---

At any point you may enter a question mark '?' for help.
User ctrl-c to abort configuration dialog at any prompt.

Default settings are in square brackets '[]'.

Current time: Wed Nov 11 21:19:51 2009
Setup Configuration last modified:

Enter host name[sensor]:
Enter IP interface[192.168.1.2/24,192.168.1.1]:
Modify current access list?[no]:
Current access list entries:
[1] 0.0.0.0/0
Delete:
Permit:
Use DNS server for Global Correlation?[no]:
DNS server IP address[171.68.226.120]:
Use HTTP proxy server for Global Correlation?[no]:
HTTP proxy server IP address[128.107.241.169]:
HTTP proxy server Port number[8080]:
Modify system clock settings?[no]:
Modify summer time settings?[no]:
Use USA SummerTime Defaults?[yes]:
Recurring, Date or Disable?[Recurring]:
Start Month[march]:
Start Week[second]:
Start Day[sunday] :
Start Time[02:00:007:
End Month[november] :
End Week[first]:
End Day[sunday] :
End Time[02:00:007:
DST Zonel]:
Offset[60]:
Modify system timezone?[no]:
Timezone [UTC] :
UTC Offset[0]:
Use NTP?[no]: yes
NTP Server IP Address|[]:
Use NTP Authentication?[no]: yes
NTP Key ID[]: 1
NTP Key Value[]: 8675309

Initializing the Sensor W

Participation in the SensorBase Network allows Cisco to collect aggregated statistics

about traffic sent to your IPS.
SensorBase Network Participation level?[off]: full

If you agree to participate in the SensorBase Network, Cisco will collect aggregated

statistics about traffic sent to your IPS.

This includes summary data on the Cisco IPS network traffic properties and how this
traffic was handled by the Cisco appliances. We do not collect the data content of traffic
or other sensitive business or personal information. All data is aggregated and sent via
secure HTTP to the Cisco SensorBase Network servers in periodic intervals. All data shared

with Cisco will be anonymous and treated as strictly confidential.
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The table below describes how the data will be used by Cisco.
Participation Level = "Partial":
* Type of Data: Protocol Attributes (e.g. TCP max segment size and
options string)
Purpose: Track potential threats and understand threat exposure
* Type of Data: Attack Type (e.g. Signature Fired and Risk Rating)
Purpose: Used to understand current attacks and attack severity
* Type of Data: Connecting IP Address and port
Purpose: Identifies attack source
* Type of Data: Summary IPS performance (CPU utilization memory usage,
inline vs. promiscuous, etc)
Purpose: Tracks product efficacy
Participation Level = "Full" additionally includes:
* Type of Data: Victim IP Address and port
Purpose: Detect threat behavioral patterns

Do you agree to participate in the SensorBase Network?[no]:

Basic Sensor Setup

Step 1

Step 2

Step 3
Step 4

Step 5

Step 6

To perform basic sensor setup using the setup command, follow these steps:

Log in to the sensor using an account with administrator privileges.

~

Note  Both the default username and password are cisco.

The first time you log in to the sensor you are prompted to change the default password. Passwords must
be at least eight characters long and be strong, that is, not be a dictionary word. After you change the
password, basic setup begins.

Enter the setup command. The System Configuration Dialog is displayed.

Specify the hostname. The hostname is a case-sensitive character string up to 64 characters. Numbers,
“_” and “-” are valid, but spaces are not acceptable. The default is sensor.

Specify the IP interface. The IP interface is in the form of IP Address/Netmask,Gateway:

XXX X/nn,Y.Y.Y.Y, where X.X.X. X specifies the sensor IP address as a 32-bit address written as 4 octets
separated by periods, nn specifies the number of bits in the netmask, and Y.Y.Y.Y specifies the default
gateway as a 32-bit address written as 4 octets separated by periods.

Enter yes to modify the network access list:

a. If you want to delete an entry, enter the number of the entry and press Enter, or press Enter to get
to the Permit line.

b. Enter the IP address and netmask of the network you want to add to the access list.

A

Note  For example, 10.0.0.0/8 permits all IP addresses on the 10.0.0.0 network
(10.0.0.0-10.255.255.255) and 10.1.1.0/24 permits only the IP addresses on the 10.1.1.0
subnet (10.1.1.0-10.1.1.255). If you want to permit access to a single IP address than the
entire network, use a 32-bit netmask. For example, 10.1.1.1/32 permits just the 10.1.1.1
address.

c. Repeat Step b until you have added all networks that you want to add to the access list, and then
press Enter at a blank permit line to go to the next step.
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Step7  You must configure a DNS server or an HTTP proxy server for global correlation to operate:
a. Enter yes to add a DNS server, and then enter the DNS server IP address.

b. Enter yes to add an HTTP proxy server, and then enter the HTTP proxy server IP address and port
number.

A

Caution  You must have a valid sensor license for global correlation features to function. You can still configure
and display statistics for the global correlation features, but the global correlation databases are cleared
and no updates are attempted. Once you install a valid license, the global correlation features are
reactivated.

Step8  Enter yes to modify the system clock settings:

a. Enter yes to modify summertime settings.

~

Note  Summertime is also known as DST. If your location does not use Summertime, go to Step m.

b. Enter yes to choose the USA summertime defaults, or enter no and choose recurring, date, or disable
to specify how you want to configure summertime settings. The default is recurring.

c. If you chose recurring, specify the month you want to start summertime settings. Valid entries are
january, february, march, april, may, june, july, august, september, october, november, and
december. The default is march.

d. Specify the week you want to start summertime settings. Valid entries are first, second, third, fourth,
fifth, and last. The default is second.

e. Specify the day you want to start summertime settings. Valid entries are sunday, monday, tuesday,
wednesday, thursday, friday, and saturday. The default is sunday.

f. Specify the time you want to start summertime settings. The default is 02:00:00.

~

Note  The default recurring summertime parameters are correct for time zones in the United States.
The default values specify a start time of 2:00 a.m. on the second Sunday in March, and a
stop time of 2:00 a.m. on the first Sunday in November. The default summertime offset is 60
minutes.

g. Specify the month you want summertime settings to end. Valid entries are january, february, march,
april, may, june, july, august, september, october, november, and december. The default is november.

h. Specify the week you want the summertime settings to end. Valid entries are first, second, third,
fourth, fifth, and last. The default is first.

i. Specify the day you want the summertime settings to end. Valid entries are sunday, monday, tuesday,
wednesday, thursday, friday, and saturday. The default is sunday.

j- Specify the time you want summertime settings to end. The default is 02:00:00.

k. Specify the DST zone. The zone name is a character string up to 24 characters long in the pattern
[A-Za-z0-9()+:,_/-]+8.

l. Specify the summertime offset. Specify the summertime offset from UTC in minutes (negative
numbers represent time zones west of the Prime Meridian). The default is 60.

m. Enter yes to modify the system time zone.

n. Specify the standard time zone name. The zone name is a character string up to 24 characters long.
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0. Specify the standard time zone offset. Specify the standard time zone offset from UTC in minutes
(negative numbers represent time zones west of the Prime Meridian). The default is 0.

p. Enter yes if you want to use NTP. To use authenticated NTP, you need the NTP server IP address,
the NTP key ID, and the NTP key value. If you do not have those at this time, you can configure
NTP later. Otherwise, you can choose unauthenticated NTP.

Step9  Enter off, partial, or full to participate in the SensorBase Network Participation:
e Off—No data is contributed to the SensorBase Network.

e Partial—Data is contributed to the SensorBase Network, but data considered potentially sensitive is
filtered out and never sent.

e Full—All data is contributed to the SensorBase Network except the attacker/victim IP addresses that
you exclude.

The SensorBase Network Participation disclaimer appears. It explains what is involved in participating
in the SensorBase Network.

Step10 Enter yes to participate in the SensorBase Network.

The following configuration was entered.
service host
network-settings

host-ip 192.168.1.2/24, 192.168.1.1
host-name sensor
telnet-option disabled
access-1list 10.0.0.0/8
ftp-timeout 300

no login-banner-text
dns-primary-server enabled
address 171.68.226.120

exit

dns-secondary-server disabled
dns-tertiary-server disabled
http-proxy proxy-server
address 128.107.241.170

port 8080

exit

time-zone-settings

offset -360
standard-time-zone-name CST
exit

summertime-option recurring
offset 60
summertime-zone-name CDT
start-summertime

month march

week-of-month second
day-of-week sunday
time-of-day 02:00:00

exit

end-summertime

month november

week-of-month first
day-of-week sunday
time-of-day 02:00:00

exit

exit

ntp-option enabled

ntp-keys 1 md5-key 8675309
ntp-servers 10.10.1.2 key-id 1
exit

service global-correlation
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Step 11

Step 12

Initializing the Sensor W

network-participation full
exit

[0] Go to the command prompt without saving this config.
[1] Return to setup without saving this config.

[2] Save this configuration and exit setup.

[3] Continue to Advanced setup.

Enter 2 to save the configuration (or 3 to continue with advanced setup using the CLI).

Enter your selection[2]: 2
Configuration Saved.

If you changed the time setting, enter yes to reboot the sensor.

Advanced Setup for the IPS Appliance

~

Note

Note

Step 1
Step 2

Step 3
Step 4
Step 5

Step 6

The currently supported Cisco IPS appliances are the IPS 4240, IPS 4255, and IPS 4260 (IPS 7.0(x) and
later and IPS 7.1(5) and later), IPS 4270-20 (IPS 7.1(3) and later), IPS 4345 and IPS 4360 (IPS 7.1(3)
and later).

Adding new subinterfaces is a two-step process. You first organize the interfaces when you edit the
virtual sensor configuration. You then choose which interfaces and subinterfaces are assigned to which
virtual sensors.

To continue with advanced setup for the appliance, follow these steps:

Log in to the appliance using an account with administrator privileges.

Enter the setup command. The System Configuration Dialog is displayed. Press Enter or the spacebar
to skip to the menu to access advanced setup.

Enter 3 to access advanced setup.
Specify the Telnet server status. The default is disabled.

Specify the web server port. The web server port is the TCP port used by the web server (1 to 65535).
The default is 443.

>
Note  The web server is configured to use TLS/SSL encryption by default. Setting the port to 80 does
not disable the encryption.

Enter yes to modify the interface and virtual sensor configuration and to see the current interface
configuration.

Current interface configuration
Command control: Management0/0
Unassigned:

Promiscuous:
GigabitEthernet0/0
GigabitEthernet0/1
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GigabitEthernet0/2
GigabitEthernet0/3

Virtual Sensor: vsO
Anomaly Detection: ad0
Event Action Rules: rulesO
Signature Definitions: sigO0

Virtual Sensor: vsl
Anomaly Detection: ad0
Event Action Rules: rulesO
Signature Definitions: sigO0

Virtual Sensor: vs2
Anomaly Detection: adO
Event Action Rules: rulesO
Signature Definitions: sig0

[1] Edit Interface Configuration
[2] Edit Virtual Sensor Configuration
[3] Display configuration

Option:

Step7  Enter 1 to edit the interface configuration.

~

Note  The following options let you create and delete interfaces. You assign the interfaces to virtual
sensors in the virtual sensor configuration. If you are using promiscuous mode for your
interfaces and are not subdividing them by VLAN, no additional configuration is necessary.

[1] Remove interface configurations.
[2] Add/Modify Inline Vlan Pairs.
[3] Add/Modify Promiscuous Vlan Groups.
[4] Add/Modify Inline Interface Pairs.
[5] Add/Modify Inline Interface Pair Vlan Groups.
[6] Modify interface default-vlan.
Option:

Step8  Enter 2 to add inline VLAN pairs and display the list of available interfaces.

A

Caution  The new VLAN pair is not automatically added to a virtual sensor.

Available Interfaces
[1] GigabitEthernet0/0
[2] GigabitEthernet0/1
[3] GigabitEthernet0/2
[4] GigabitEthernet0/3
Option:

Step9  Enter 1 to add an inline VLAN pair to GigabitEthernet 0/0, for example.
Inline Vlan Pairs for GigabitEthernet0/0
None
Step10 Enter a subinterface number and description.

Subinterface Number:
Description[Created via setup by user asmith]:
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Step 11

Step 12

Step 13

Step 14

Step 15

Step 16

Step 17

Enter numbers for VLAN 1 and 2.

Vlanl[]: 200
Vlan2[]: 300

Press Enter to return to the available interfaces menu.

S

Initializing the Sensor

Note  Entering a carriage return at a prompt without a value returns you to the previous menu.

[1] GigabitEthernet0/0

[2] GigabitEthernet0/1

[3] GigabitEthernet0/2

[4] GigabitEthernet0/3
Option:

~

Note At this point, you can configure another interface, for example, GigabitEthernet 0/1, for inline

VLAN pair.

Press Enter to return to the top-level interface editing menu.

[1] Remove interface configurations.
[2] Add/Modify Inline Vlan Pairs.
[3] Add/Modify Promiscuous Vlan Groups.
[4] Add/Modify Inline Interface Pairs.
[5] Add/Modify Inline Interface Pair Vlan Groups.
[6] Modify interface default-vlan.
Option:

Enter 4 to add an inline interface pair and see these options.

Available Interfaces
GigabitEthernet0/1
GigabitEthernet0/2
GigabitEthernet0/3

Enter the pair name, description, and which interfaces you want to pair.

Pair name: newPair

Description[Created via setup by user asmith:
Interfacel[]: GigabitEthernet0/1
Interface2[]: GigabitEthernet0/2

Pair name:

Press Enter to return to the top-level interface editing menu.

[1] Remove interface configurations.
[2] Add/Modify Inline Vlan Pairs.
[3] Add/Modify Promiscuous Vlan Groups.
[4] Add/Modify Inline Interface Pairs.
[5] Add/Modify Inline Interface Pair Vlan Groups.
[6] Modify interface default-vlan.
Option:

Press Enter to return to the top-level editing menu.

[1] Edit Interface Configuration
[2] Edit Virtual Sensor Configuration
[3] Display configuration

Option:
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Step18 Enter 2 to edit the virtual sensor configuration.

[1] Remove virtual sensor.
[2] Modify "vs0" virtual sensor configuration.
[3] Create new virtual sensor.

Option:

Step19 Enter 2 to modify the virtual sensor configuration, vs0.

Virtual Sensor: vsO
Anomaly Detection: ad0
Event Action Rules: rulesO
Signature Definitions: sigO0

No Interfaces to remove.

Unassigned:

Promiscuous:
[1] GigabitEthernet0/3
[2] GigabitEthernet0/0

Inline Vlan Pair:
[3] GigabitEthernet0/0:1 (Vlans: 200, 300)

Inline Interface Pair:
[4] newPair (GigabitEthernet0/1, GigabitEthernet0/2)

Add Interface:

Step20 Enter 3 to add inline VLAN pair GigabitEthernet0/0:1.
Step21 Enter 4 to add inline interface pair NewPair.

Step22 Press Enter to return to the top-level virtual sensor menu.

Virtual Sensor: vsO
Anomaly Detection: ad0
Event Action Rules: rulesO
Signature Definitions: sigO0
Inline Vlan Pair:
GigabitEthernet0/0:1 (Vlans: 200, 300)
Inline Interface Pair:
newPair (GigabitEthernet0/1, GigabitEthernet0/2)

[1] Remove virtual sensor.
[2] Modify "vs0" virtual sensor configuration.
[3] Create new virtual sensor.
Option: GigabitEthernet0/1l, GigabitEthernet0/2)
Add Interface:

Step23 Press Enter to return to the top-level interface and virtual sensor configuration menu.

[1] Edit Interface Configuration
[2] Edit Virtual Sensor Configuration
[3] Display configuration

Option:

Step24 Enter yes if you want to modify the default threat prevention settings.

>
Note  The sensor comes with a built-in override to add the deny packet event action to high risk rating
alerts. If you do not want this protection, disable automatic threat prevention.

Virtual sensor newVs is configured to prevent high risk threats in inline mode. (Risk
Rating 90-100)

Virtual sensor vs0 is configured to prevent high risk threats in inline mode. (Risk Rating
90-100)
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Step 25
Step 26

Initializing the Sensor

Do you want to disable automatic threat prevention on all virtual sensors?[no]:

Enter yes to disable automatic threat prevention on all virtual sensors.

Press Enter to exit the interface and virtual sensor configuration.

The following configuration was entered.

service host

network-settings

host-ip 192.168.1.2/24,192.168.1.1
host-name sensor

telnet-option disabled

ftp-timeout 300

no login-banner-text

exit

time-zone-settings

offset 0
standard-time-zone-name UTC
exit

summertime-option disabled

ntp-option disabled

exit

service web-server

port 342

exit

service interface

physical-interfaces GigabitEthernet0/0
admin-state enabled

subinterface-type inline-vlan-pair
subinterface 1

description Created via setup by user
vlanl 200

vlan2 300

exit

exit

exit

physical-interfaces GigabitEthernet0/1
admin-state enabled

exit

physical-interfaces GigabitEthernet0/2
admin-state enabled

exit

physical-interfaces GigabitEthernet0/0
admin-state enabled

exit

inline-interfaces newPair

description Created via setup by user
interfacel GigabitEthernet0/1
interface2 GigabitEthernet0/2

exit

exit

service analysis-engine
virtual-sensor newVs

description Created via setup by user
signature-definition newSig
event-action-rules rulesO
anomaly-detection
anomaly-detection-name ad0
operational-mode inactive

exit

physical-interface GigabitEthernet0/0
exit

virtual-sensor vsO

physical-interface GigabitEthernet0/0

asmith

asmith

cisco

subinterface-number 1
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Step 27

Step 28

Step 29
Step 30

logical-interface newPair

service event-action-rules rulesO
overrides deny-packet-inline
override-item-status Disabled
risk-rating-range 90-100

exit

exit

[0] Go to the command prompt without saving this config.
[1] Return back to the setup without saving this config.
[2] Save this configuration and exit setup.

Enter 2 to save the configuration.

Enter your selection[2]: 2

Configuration Saved.

Reboot the appliance.

sensor# reset
Warning: Executing this command will stop all applications and reboot the node.
Continue with reset? []:

Enter yes to continue the reboot.

Apply the most recent service pack and signature update. You are now ready to configure your appliance
for intrusion prevention.

Advanced Setup for the ASA 5500 AIP SSM

Step 1

Step 2

Step 3
Step 4
Step 5

Step 6

To continue with advanced setup for the ASA 5500 AIP SSM, follow these steps:

Session in to the ASA 5500 AIP SSM using an account with administrator privileges.

asa# session 1

Enter the setup command. The System Configuration Dialog is displayed. Press Enter or the spacebar
to skip to the menu to access advanced setup.

Enter 3 to access advanced setup.

Specify the Telnet server status. You can disable or enable Telnet services. The default is disabled.

Specify the web server port. The web server port is the TCP port used by the web server (1 to 65535).
The default is 443.

~

Note  The web server is configured to use TLS/SSL encryption by default. Setting the port to 80 does
not disable the encryption.

Enter yes to modify the interface and virtual sensor configuration.

Current interface configuration
Command control: Management0/0
Unassigned:

Monitored:
GigabitEthernet0/1

Virtual Sensor: vsO
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Step 7

Step 8

Step 9

Step 10

Step 11

Step 12
Step 13

Anomaly Detection: adO
Event Action Rules: rulesO
Signature Definitions: sig0

[1] Edit Interface Configuration
[2] Edit Virtual Sensor Configuration
[3] Display configuration

Option:

Enter 1 to edit the interface configuration.

~

Initializing the Sensor

Note  You do not need to configure interfaces on the ASA 5500 AIP SSM. You should ignore the
modify interface default VLAN setting. The separation of traffic across virtual sensors is

configured differently for the ASA 5500 AIP SSM than for other sensors.

[1] Modify interface default-vlan.
Option:

Press Enter to return to the top-level interface and virtual sensor configuration menu.

[1] Edit Interface Configuration
[2] Edit Virtual Sensor Configuration
[3] Display configuration

Option:

Enter 2 to edit the virtual sensor configuration.

[1] Remove virtual sensor.
[2] Modify "vs0" virtual sensor configuration.
[3] Create new virtual sensor.

Option:

Enter 2 to modify the virtual sensor vsO configuration.

Virtual Sensor: vsO
Anomaly Detection: ad0
Event Action Rules: rulesO
Signature Definitions: sigO0

No Interfaces to remove.

Unassigned:
Monitored:
[1] GigabitEthernet0/1
Add Interface:

Enter 1 to add GigabitEthernet 0/1 to virtual sensor vs0.

S

Note  Multiple virtual sensors are supported. The adaptive security appliance can direct packets to

specific virtual sensors or can send packets to be monitored by a default virtual sensor. The
default virtual sensor is the virtual sensor to which you assign GigabitEthernet 0/1. We
recommend that you assign GigabitEthernet 0/1 to vs0, but you can assign it to another virtual

sensor if you want to.

Press Enter to return to the main virtual sensor menu.
Enter 3 to create a virtual sensor.

Name[]:
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Step 14

Step 15

Step 16
Step 17

Step 18

Step 19

Step 20

Step 21

Enter a name and description for your virtual sensor.

Name[]: newVs
Description[Created via setup by user ciscol]l: New Sensor
Anomaly Detection Configuration

[1] ado
[2] Create a new anomaly detection configuration
Option[2]:

Enter 1 to use the existing anomaly detection configuration, ad0.

Signature Definition Configuration

[1] sig0
[2] Create a new signature definition configuration
Option[2]:

Enter 2 to create a signature-definition configuration file.
Enter the signature-definition configuration name, newsig.

Event Action Rules Configuration

[1] rulesO

[2] Create a new event action rules configuration
Option[2]:

Enter 1 to use the existing event-action-rules configuration, rules0.

S

Note  If GigabitEthernet 0/1 has not been assigned to vsO, you are prompted to assign it to the new
virtual sensor.

Virtual Sensor: newVs
Anomaly Detection: adO
Event Action Rules: rulesO
Signature Definitions: newSig
Monitored:
GigabitEthernet0/1

[1] Remove virtual sensor.
[2] Modify "newVs" virtual sensor configuration.
[3] Modify "vs0" virtual sensor configuration.
[4] Create new virtual sensor.
Option:
Press Enter to exit the interface and virtual sensor configuration menu.

Modify default threat prevention settings?[no]:

Enter yes if you want to modify the default threat prevention settings.

~

Note  The sensor comes with a built-in override to add the deny packet event action to high risk rating
alerts. If you do not want this protection, disable automatic threat prevention.

Virtual sensor newVs is configured to prevent high risk threats in inline mode. (Risk
Rating 90-100)

Virtual sensor vs0O is configured to prevent high risk threats in inline mode. (Risk Rating
90-100)

Do you want to disable automatic threat prevention on all virtual sensors?[no]:

Enter yes to disable automatic threat prevention on all virtual sensors.

The following configuration was entered.
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service host

network-settings

host-ip 10.1.9.201/24,10.1.9.1
host-name aip-ssm
telnet-option disabled
access-1list 10.0.0.0/8
access-list 64.0.0.0/8
ftp-timeout 300

no login-banner-text

exit

time-zone-settings

offset 0
standard-time-zone-name UTC
exit

summertime-option disabled
ntp-option disabled

exit

service web-server

port 342

exit

service analysis-engine
virtual-sensor newVs
description New Sensor
signature-definition newSig
event-action-rules rulesO
anomaly-detection
anomaly-detection-name ad0
exit

physical-interfaces GigabitEthernet0/1
exit

exit

service event-action-rules rulesO
overrides deny-packet-inline
override-item-status Disabled
risk-rating-range 90-100

exit

exit

[0] Go to the command prompt without saving this config.
[1] Return back to the setup without saving this config.
[2] Save this configuration and exit setup.

Step22 Enter 2 to save the configuration.

Enter your selection[2]: 2
Configuration Saved.

Step23 Reboot the ASA 5500 AIP SSM.

aip-ssm# reset
Warning: Executing this command will stop all applications and reboot the node.
Continue with reset? []:

Step24 Enter yes to continue the reboot.
Step25 After reboot, log in to the sensor, and display the self-signed X.509 certificate (needed by TLS).

aip-ssm# show tls fingerprint
MD5: C4:BC:F2:92:C2:E2:4D:EB:92:0F:E4:86:53:6A:C6:01
SHALl: 64:9B:AC:DE:21:62:0C:D3:57:2E:9B:E5:3D:04:8F:A7:FD:CD:6F:27

Step26 Write down the certificate fingerprints. You need the fingerprints to check the authenticity of the
certificate when using HTTPS to connect to this ASA 5500 AIP SSM with a web browser.
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Step 27

Apply the most recent service pack and signature update. You are now ready to configure your
ASA 5500 AIP SSM for intrusion prevention.

Advanced Setup for the ASA 5500-X IPS SSP

Step 1

Step 2

Step 3
Step 4
Step 5

Step 6

Step 7

Step 8

To continue with advanced setup for the ASA 5500-X IPS SSP, follow these steps:

Session in to the IPS using an account with administrator privileges.

asa# session ips

Enter the setup command. The System Configuration Dialog is displayed. Press Enter or the spacebar
to skip to the menu to access advanced setup.

Enter 3 to access advanced setup.

Specify the Telnet server status. You can disable or enable Telnet services. The default is disabled.

Specify the web server port. The web server port is the TCP port used by the web server (1 to 65535).
The default is 443.

~

Note  The web server is configured to use TLS/SSL encryption by default. Setting the port to 80 does
not disable the encryption.

Enter yes to modify the interface and virtual sensor configuration.

Current interface configuration
Command control: Management0/0
Unassigned:

Monitored:
PortChannel 0/0

Virtual Sensor: vsO
Anomaly Detection: adO
Event Action Rules: rulesO
Signature Definitions: sigO0

[1] Edit Interface Configuration
[2] Edit Virtual Sensor Configuration
[3] Display configuration

Option:

Enter 1 to edit the interface configuration.

>

Note  You do not need to configure interfaces on the ASA 5500-X IPS SSP. You should ignore the
modify interface default VLAN setting. The separation of traffic across virtual sensors is
configured differently for the ASA 5500-X IPS SSP than for other sensors.

[1] Modify interface default-vlan.
Option:
Press Enter to return to the top-level interface and virtual sensor configuration menu.

[1] Edit Interface Configuration
[2] Edit Virtual Sensor Configuration
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Step 9

Step 10

Step 11

Step 12
Step 13

Step 14

Step 15

Step 16
Step 17

Initializing the Sensor

[3] Display configuration
Option:

Enter 2 to edit the virtual sensor configuration.

[1] Remove virtual sensor.
[2] Modify "vs0" virtual sensor configuration.
[3] Create new virtual sensor.

Option:

Enter 2 to modify the virtual sensor vsO configuration.

Virtual Sensor: vsO
Anomaly Detection: ad0
Event Action Rules: rulesO
Signature Definitions: sigO0

No Interfaces to remove.
Unassigned:
Monitored:

[1] PortChannel 0/0
Add Interface:

Enter 1 to add PortChannel 0/0 to virtual sensor vsO.

a~

Note  Multiple virtual sensors are supported. The adaptive security appliance can direct packets to
specific virtual sensors or can send packets to be monitored by a default virtual sensor. The

default virtual sensor is the virtual sensor to which you assign PortChannel 0/0. We recommend
that you assign PortChannel 0/0 to vs0, but you can assign it to another virtual sensor if you want

to.

Press Enter to return to the main virtual sensor menu.
Enter 3 to create a virtual sensor.

Name[]:

Enter a name and description for your virtual sensor.

Name[]: newVs
Description[Created via setup by user cisco]: New Sensor
Anomaly Detection Configuration

[1] adO
[2] Create a new anomaly detection configuration
Optionl[2]:

Enter 1 to use the existing anomaly-detection configuration, ad0.

Signature Definition Configuration

[1] sig0
[2] Create a new signature definition configuration
Option[2]:

Enter 2 to create a signature-definition configuration file.
Enter the signature-definition configuration name, newsig.

Event Action Rules Configuration

[1] rulesO

[2] Create a new event action rules configuration
Option[2]:
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Step18 Enter 1 to use the existing event-action-rules configuration, rules0.

a~

Note If PortChannel 0/0 has not been assigned to vs0, you are prompted to assign it to the new virtual
Sensor.

Virtual Sensor: newVs
Anomaly Detection: adO
Event Action Rules: rulesO
Signature Definitions: newSig
Monitored:
PortChannel0/0

[1] Remove virtual sensor.
[2] Modify "newVs" virtual sensor configuration.
[3] Modify "vs0" virtual sensor configuration.
[4] Create new virtual sensor.

Option:

Step19 Press Enter to exit the interface and virtual sensor configuration menu.

Modify default threat prevention settings?[no]:

Step20 Enter yes if you want to modify the default threat prevention settings.

~

Note  The sensor comes with a built-in override to add the deny packet event action to high risk rating
alerts. If you do not want this protection, disable automatic threat prevention.

Virtual sensor newVs is configured to prevent high risk threats in inline mode. (Risk
Rating 90-100)

Virtual sensor vs0 is configured to prevent high risk threats in inline mode. (Risk Rating
90-100)

Do you want to disable automatic threat prevention on all virtual sensors?[no]:

Step21  Enter yes to disable automatic threat prevention on all virtual sensors.

The following configuration was entered.

service host

network-settings

host-ip 192.168.1.2/24,192.168.1.1
host-name asa-ips

telnet-option disabled

access-1list 10.0.0.0/8

access-1list 64.0.0.0/8

ftp-timeout 300

no login-banner-text

exit

time-zone-settings

offset 0
standard-time-zone-name UTC
exit

summertime-option disabled
ntp-option disabled

exit

service web-server

port 342

exit

service analysis-engine
virtual-sensor newvVs
description New Sensor
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Step 23

Step 24
Step 25

Step 26

Step 27

Initializing the Sensor W

signature-definition newSig
event-action-rules rulesO
anomaly-detection
anomaly-detection-name ad0

exit

physical-interfaces PortChannel0/0
exit

exit

service event-action-rules rulesO
overrides deny-packet-inline
override-item-status Disabled
risk-rating-range 90-100

exit

exit

[0] Go to the command prompt without saving this config.
[1] Return back to the setup without saving this config.
[2] Save this configuration and exit setup.

Enter 2 to save the configuration.

Enter your selection[2]: 2
Configuration Saved.

Reboot the ASA 5500-X IPS SSP.

asa-ips# reset
Warning: Executing this command will stop all applications and reboot the node.
Continue with reset? []:

Enter yes to continue the reboot.
After reboot, log in to the sensor, and display the self-signed X.509 certificate (needed by TLS).

asa-ips# show tls fingerprint
MD5: C4:BC:F2:92:C2:E2:4D:EB:92:0F:E4:86:53:6A:C6:01
SHALl: 64:9B:AC:DE:21:62:0C:D3:57:2E:9B:E5:3D:04:8F:A7:FD:CD:6F:27

Write down the certificate fingerprints. You need the fingerprints to check the authenticity of the
certificate when using HTTPS to connect to this ASA 5500-X IPS SSP with a web browser.

Apply the most recent service pack and signature update. You are now ready to configure the
ASA 5500-X IPS SSP for intrusion prevention.

Advanced Setup for the ASA 5585-X IPS SSP

Step 1

Step 2

Step 3
Step 4

To continue with advanced setup for the ASA 5585-X IPS SSP, follow these steps:

Session in to the ASA 5585-X IPS SSP using an account with administrator privileges.

asa# session 1

Enter the setup command. The System Configuration Dialog is displayed. Press Enter or the spacebar
to skip to the menu to access advanced setup.

Enter 3 to access advanced setup.

Specify the Telnet server status. You can disable or enable Telnet services. The default is disabled.
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Step 5

Step 6

Step 7

Step 8

Step 9

Step 10

Specify the web server port. The web server port is the TCP port used by the web server (1 to 65535).
The default is 443.

~

Note  The web server is configured to use TLS/SSL encryption by default. Setting the port to 80 does
not disable the encryption.

Enter yes to modify the interface and virtual sensor configuration.

Current interface configuration
Command control: Management0/0
Unassigned:

Monitored:
PortChannel0/0

Virtual Sensor: vs0
Anomaly Detection: adO
Event Action Rules: rulesO
Signature Definitions: sig0

[1] Edit Interface Configuration
[2] Edit Virtual Sensor Configuration
[3] Display configuration

Option:

Enter 1 to edit the interface configuration.

~

Note  You do not need to configure interfaces on the ASA 5585-X IPS SSP. You should ignore the
modify interface default VLAN setting. The separation of traffic across virtual sensors is
configured differently for the ASA 5585-X IPS SSP than for other sensors.

[1] Modify interface default-vlan.
Option:

Press Enter to return to the top-level interface and virtual sensor configuration menu.

[1] Edit Interface Configuration
[2] Edit Virtual Sensor Configuration
[3] Display configuration

Option:

Enter 2 to edit the virtual sensor configuration.

[1] Remove virtual sensor.
[2] Modify "vs0" virtual sensor configuration.
[3] Create new virtual sensor.

Option:

Enter 2 to modify the virtual sensor vsO configuration.

Virtual Sensor: vsO
Anomaly Detection: adO
Event Action Rules: rulesO
Signature Definitions: sigO0

No Interfaces to remove.

Unassigned:
Monitored:
[1] PortChannel0/0
Add Interface:
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Step11  Enter 1 to add PortChannel 0/0 to virtual sensor vs0.

a~

Note  Multiple virtual sensors are supported. The adaptive security appliance can direct packets to
specific virtual sensors or can send packets to be monitored by a default virtual sensor. The
default virtual sensor is the virtual sensor to which you assign PortChannel 0/0. We recommend
that you assign PortChannel 0/0 to vs0, but you can assign it to another virtual sensor if you want
to.

Step12 Press Enter to return to the main virtual sensor menu.

Step13  Enter 3 to create a virtual sensor.

Name[] :

Step14 Enter a name and description for your virtual sensor.

Name[]: newVs
Description[Created via setup by user cisco]: New Sensor
Anomaly Detection Configuration

[1] ado
[2] Create a new anomaly detection configuration
Option[2]:

Step15 Enter 1 to use the existing anomaly-detection configuration, ad0.

Signature Definition Configuration

[1] sigO0
[2] Create a new signature definition configuration
Option[2]:

Step16  Enter 2 to create a signature-definition configuration file.

Step17  Enter the signature-definition configuration name, newsig.

Event Action Rules Configuration

[1] rulesO

[2] Create a new event action rules configuration
Optionl[2]:

Step 18  Enter 1 to use the existing event action rules configuration, rulesO.

~

Note  If PortChannel 0/0 has not been assigned to vs0, you are prompted to assign it to the new virtual
Sensor.

Virtual Sensor: newVs
Anomaly Detection: adO
Event Action Rules: rulesO
Signature Definitions: newSig
Monitored:
PortChannel0/0

[1] Remove virtual sensor.
[2] Modify "newVs" virtual sensor configuration.
[3] Modify "vsO0" virtual sensor configuration.
[4] Create new virtual sensor.

Option:

Step19 Press Enter to exit the interface and virtual sensor configuration menu.

Modify default threat prevention settings?[no]:
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Step20 Enter yes if you want to modify the default threat prevention settings.

a~

Note  The sensor comes with a built-in override to add the deny packet event action to high risk rating
alerts. If you do not want this protection, disable automatic threat prevention.

Virtual sensor newVs is configured to prevent high risk threats in inline mode. (Risk
Rating 90-100)

Virtual sensor vsO is configured to prevent high risk threats in inline mode. (Risk Rating
90-100)

Do you want to disable automatic threat prevention on all virtual sensors?[no]:

Step21  Enter yes to disable automatic threat prevention on all virtual sensors.

The following configuration was entered.

service host

network-settings

host-ip 10.1.9.201/24,10.1.9.1
host-name sensor
telnet-option disabled
access-1list 10.0.0.0/8
access-list 64.0.0.0/8
ftp-timeout 300

no login-banner-text

exit

time-zone-settings

offset 0
standard-time-zone-name UTC
exit

summertime-option disabled
ntp-option disabled

exit

service web-server

port 342

exit

service analysis-engine
virtual-sensor newVs
description New Sensor
signature-definition newSig
event-action-rules rules0
anomaly-detection
anomaly-detection-name ad0
exit

physical-interfaces PortChannel0/0
exit

exit

service event-action-rules rulesO
overrides deny-packet-inline
override-item-status Disabled
risk-rating-range 90-100

exit

exit

[0] Go to the command prompt without saving this config.
[1] Return back to the setup without saving this config.
[2] Save this configuration and exit setup.

Step22 Enter 2 to save the configuration.

Enter your selection[2]: 2
Configuration Saved.
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Step 24
Step 25

Step 26

Step 27
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Reboot the ASA 5585-X TIPS SSP.

ips-ssp# reset
Warning: Executing this command will stop all applications and reboot the node.
Continue with reset? []:

Enter yes to continue the reboot.
After reboot, log in to the sensor, and display the self-signed X.509 certificate (needed by TLS).

ips-ssp# show tls fingerprint
MD5: C4:BC:F2:92:C2:E2:4D:EB:92:0F:E4:86:53:6A:C6:01
SHALl: 64:9B:AC:DE:21:62:0C:D3:57:2E:9B:E5:3D:04:8F:A7:FD:CD:6F:27

Write down the certificate fingerprints. You need the fingerprints to check the authenticity of the
certificate when using HTTPS to connect to this ASA 5585-X IPS SSP with a web browser.

Apply the most recent service pack and signature update. You are now ready to configure your
ASA 5585-X IPS SSP for intrusion prevention.

Verifying Initialization

~

Note

Step 1
Step 2

The following show configuration output is an example of what your configuration may look like. It
will not match exactly because of the optional setup choices.

To verify that you initialized your sensor, follow these steps:

Log in to the sensor.
View your configuration.

sensor# show configuration

! Version 7.1(5)

! Host:

! Realm Keys keyl.0

! Signature Definition:

! Signature Update S648.0 2012-05-30

service interface
exit

service authentication
exit

service event-action-rules rulesO
exit

service host

network-settings

host-ip 192.168.1.2/24, 192.168.1.1
host-name sensor

telnet-option enabled

access-1list 0.0.0.0/0
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dns-primary-server disabled
dns-secondary-server disabled
dns-tertiary-server disabled
exit

time-zone-settings

offset -360
standard-time-zone-name CST
exit

ntp-option enabled-ntp-unauthenticated
ntp-server 171.68.10.150

exit

summertime-option recurring
summertime-zone-name CDT

exit

exit

service logger
exit

service network-access
exit

service notification
exit

service signature-definition sig0
exit

service ssh-known-hosts
exit

service trusted-certificates
exit

service web-server
exit

service anomaly-detection adO
exit

service external-product-interface
exit

service health-monitor
exit

service global-correlation
exit

service aaa
exit

service analysis-engine

exit
sensor#

~

Note  You can also use the more current-config command to view your configuration.

Step3  Display the self-signed X.509 certificate (needed by TLS).

sensor# show tls fingerprint
MD5: C4:BC:F2:92:C2:E2:4D:EB:92:0F:E4:86:53:6A:C6:01
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Logging Into the IDM

SHAl: 64:9B:AC:DE:21:62:0C:D3:57:2E:9B:E5:3D:04:8F:A7:FD:CD:6F:27

Write down the certificate fingerprints. You need the fingerprints to check the authenticity of the
certificate when connecting to this sensor with a web browser.

Logging In to the IDM

Note

Step 1

Step 2
Step 3

Step 4

Step 5

Step 6

The IDM is a web-based, Java Web Start application that enables you to configure and manage your
sensor. The web server for the IDM resides on the sensor. You can access it through Internet Explorer or
Firefox web browsers.

The IDM is already installed on the sensor.

To log in to the IDM, follow these steps:

Open a web browser and enter the sensor IP address. A Security Alert dialog box appears.

https://sensor_ip_address

S

Note  The default IP address is 192.168.1.2/24,192.168.1.1, which you change to reflect your network
environment when you initialize the sensor. When you change the web server port, you must
specify the port in the URL address of your browser when you connect to the IDM in the format
https://sensor_ip_address:port (for example, https://192.0.2.1:1040).

Click Yes to accept the security certificate. The Cisco IPS Device Manager Version window appears.

To launch the IDM, click Run IDM. The JAVA loading message box appears, and then the Warning -
Security dialog box appears.

To verify the security certificate, check the Always trust content from this publisher check box, and click
Yes. The JAVA Web Start progress dialog box appears, and then the IDM on ip_address dialog box
appears.

To create a shortcut for the IDM, click Yes. The Cisco IDM Launcher dialog box appears.

~

Note  You must have JRE 1.5 (JAVA 5) installed to create shortcuts for the IDM. If you have JRE 1.6
(JAVA 6) installed, the shortcut is created automatically.

To authenticate the IDM, enter your username and password, and click OK. Both the default username
and password are cisco. You were prompted to change the password during sensor initialization. The
IDM begins to load. If you change panes from Home to Configuration or Monitoring before the IDM has
completed initialization, a Status dialog box appears with the following message:

Please wait while IDM is loading the current configuration from the sensor.

The main window of the IDM appears.
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~

Note If you created a shortcut, you can launch the IDM by double-clicking the IDM shortcut icon. You
can also close the The Cisco IPS Device Manager Version window. After you launch the IDM,
it is not necessary for this window to remain open.

Installing or Upgrading the IME

A

This section describes how to install and upgrade the IME, and how to migrate data from IEV or a
previous version of IME.

Cisco IEV, Cisco 10S IPS, and CSM
If you have a version of Cisco IPS Event Viewer installed, the Install wizard prompts you to remove it
before installing the IME.

The IME event monitoring is also supported in IOS-IPS versions that support the Cisco IPS 5.x/6.x
signature format. We recommend [OS-IPS 12.4(15)T4 if you intend to use the IME to monitor an 10S
IPS device. Some of the new IME functionality including health monitoring is not supported.

Caution

Note

Do not install the IME on top of existing installations of CSM. You must uninstall CSM before installing
the IME.

Installation Notes and Caveats

If you are using Windows 7 or Windows Server 2008, and an IME version earlier than 7.1.1, uninstall
IME before upgrading it. Otherwise, just upgrade from your current IME version.

Observe the following when installing or upgrading the IME:

¢ You can install the IME over all versions of the IME but not over IEV. All alert database and user
settings are preserved.

e The IME detects previous versions of IEV and prompts you to manually remove the older version
before installing the IME or to install the IME on another system. The installation program then
stops.

e Make sure you close any open instances of the IME before upgrading to a new version of the IME.

e Disable any anti-virus or host-based intrusion detection software before beginning the installation,
and close any open applications. The installer spawns a command shell application that may trigger
your host-based detection software, which causes the installation to fail.

¢ You must be administrator to install the IME.

e The IME coexists with other instances of the MySQL database. If you have a MySQL database
installed on your system, you do NOT have to uninstall it before installing the IME.
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Step 2

Step 3
Step 4
Step 5

Note

Step 1
Step 2
Step 3

Step 1
Step 2

Installing or Upgrading the IME ||

Installing or Upgrading the IME
To install the IME, follow these steps:

From the Download Software site on Cisco.com, download the IME executable file to your computer, or
start the IDM in a browser window, and under Cisco IPS Manager Express, click download to install the
IME executable file. IME-7.2.2.exe is an example of what the IME executable file might look like.

Double-click the executable file. The Cisco IPS Manager Express - InstallShield Wizard appears. You
receive a warning if you have a previous version of Cisco IPS Event Viewer installed. Acknowledge the
warning, and exit installation. Remove the older version of IEV, and then continue the IME installation

Click Next to start the IME installation.
Accept the license agreement and click Next.

Click Next to choose the destination folder, click Install to install the IME, and then click Finish to exit
the wizard. The Cisco IME and Cisco IME Demo icons are now on your desktop.

~

Note  The first time you start the IME, you are prompted to set up a password.

Migrating IEV Data

To migrate IEV 5.x events to the IME, you must exit the installation and manually export the old events
by using the IEV 5.x export function to move the data to local files. After installing the IME, you can
import these files to the new IME system.

The IME does not support import and migration functions for IEV 4.x.

To export event data from IEV 5.x to a local file:

From IEV 5.x, choose File > Database Administration > Export Database Tables.
Enter the file name and select the table(s).

Click OK. The events in the selected table(s) are exported to the specified local file.

Importing IEV Event Data In to IME
To import event data in to the IME, follow these steps:

From the IME, choose File > Import.

Select the file exported from IEV 5.x and click Open. The contents of the selected file are imported in
to the IME.

For More Information

For more information about the IME, refer to Cisco Intrusion Prevention System Manager Express
Installation Guide for IPS 7.1.
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Il Enabling Anomaly Detection

Enabling Anomaly Detection
N

Note Anomaly detection is disabled by default in IPS 7.1(2)E4 and later. You must enable it to configure or
apply an anomaly detection policy. Enabling anomaly detection results in a decrease in performance.

The following section explains how to enable anomaly detection through the IDM, IME, and the CLI. It
contains the following topics:

e Enabling Anomaly Detection Using the IDM or IME, page 64
e Enabling Anomaly Detection Using the CLI, page 65

Enabling Anomaly Detection Using the IDM or IME

To enable anomaly detection, follow these steps:

Step1  Log in to the IDM or IME using an account with administrator or operator privileges.
Step2  Choose Configuration > Policies > IPS Policies.
Step3  Select the virtual sensor for which you want to turn on anomaly detection, and then click Edit.

Step4  Under Anomaly Detection, choose an anomaly detection policy from the Anomaly Detection Policy
drop-down list. Unless you want to use the default ad0O, you must have already added a anomaly detection
policy by choosing Configuration > Policies > Anomaly Detections > Add.

Step5  Choose Detect as the anomaly detection mode from the AD Operational Mode drop-down list. The
default is Inactive.

Je

ﬁ To discard your changes and close the Edit Virtual Sensor dialog box, click Cancel.

Step6  Click OK.

Tip To discard your changes, click Reset.

Step7  Click Apply to apply your changes and save the revised configuration.

For More Information

For more detailed information about anomaly detection, refer to Configuring Anomaly Detection.
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Enabling Anomaly Detection Using the CLI

To enable anomaly detection, follow these steps:

Step 1 Log in to the CLI using an account with administrator privileges.
Step2  Enter analysis engine submode.

sensor# configure terminal
sensor (config) # service analysis-engine
sensor (config-ana) #

Step3  Enter the virtual sensor name that contains the anomaly detection policy you want to enable.

sensor (config-ana) # virtual-sensor vs0
sensor (config-ana-vir) #

Stepd  Enable anomaly detection operational mode.

sensor (config-ana-vir)# anomaly-detection
sensor (config-ana-vir-ano)# operational-mode detect
sensor (config-ana-vir-ano) #

Step5  Exit analysis engine submode.

sensor (config-ana-vir-ano) # exit
sensor (config-ana-vir) # exit
sensor (config-ana-) # exit

Apply Changes:?[yes]:

Step6  Press Enter to apply your changes or enter no to discard them.

For More Information

For more detailed information about anomaly detection, refer to Configuring Anomaly Detection.

Disabling Anomaly Detection

The following section explains how to disable anomaly detection through the IDM, IME, or the CLI. It
contains the following topics:

e Disabling Anomaly Detection Using IDM or IME, page 65
e Disabling Anomaly Detection Using the CLI, page 66

Disabling Anomaly Detection Using IDM or IME

To disable anomaly detection, follow these steps:

Step1  Log in to IDM or IME using an account with administrator or operator privileges.
Step2  Choose Configuration > Policies > IPS Policies.

Step3  Select the virtual sensor for which you want to turn off anomaly detection, and then click Edit.
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Stepd  Under Anomaly Detection, from the AD Operational Mode drop-down list, choose Inactive as the
anomaly detection mode.

Je

Tip To discard your changes and close the Edit Virtual Sensor dialog box, click Cancel.

Step5 Click OK.

Tip To discard your changes, click Reset.

Step6  Click Apply to apply your changes and save the revised configuration.

For More Information

For more detailed information about anomaly detection, refer to Configuring Anomaly Detection.

Disabling Anomaly Detection Using the CLI

If you have anomaly detection enabled and you have your sensor configured to see only one direction of
traffic, you should disable anomaly detection. Otherwise, you will receive many alerts, because anomaly
detection sees asymmetric traffic as having incomplete connections, that is, like worm scanners, and fires
alerts.

To disable anomaly detection, follow these steps:

Step1  Log in to the CLI using an account with administrator privileges.
Step2  Enter analysis engine submode.

sensor# configure terminal
sensor (config)# service analysis-engine
sensor (config-ana) #

Step3  Enter the virtual sensor name that contains the anomaly detection policy you want to disable.
sensor (config-ana)# virtual-sensor vs0
sensor (config-ana-vir) #

Step4  Disable anomaly detection operational mode.

sensor (config-ana-vir)# anomaly-detection
sensor (config-ana-vir-ano)# operational-mode inactive
sensor (config-ana-vir-ano) #

Step5  Exit analysis engine submode.

sensor (config-ana-vir-ano) # exit
sensor (config-ana-vir) # exit
sensor (config-ana-) # exit

Apply Changes:?[yes]:

Step6  Press Enter to apply your changes or enter no to discard them.
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For More Information

For more detailed information about anomaly detection, refer to Configuring Anomaly Detection.

Cisco Security Intelligence Operations

The Cisco Security Intelligence Operations site on Cisco.com provides intelligence reports about current
vulnerabilities and security threats. It also has reports on other security topics that help you protect your
network and deploy your security systems to reduce organizational risk.

You should be aware of the most recent security threats so that you can most effectively secure and
manage your network. Cisco Security Intelligence Operations contains the top ten intelligence reports
listed by date, severity, urgency, and whether there is a new signature available to deal with the threat.

Cisco Security Intelligence Operations contains a Security News section that lists security articles of
interest. There are related security tools and links.

You can access Cisco Security Intelligence Operations at this URL:
http://tools.cisco.com/security/center/home.x

Cisco Security Intelligence Operations is also a repository of information for individual signatures,
including signature ID, type, structure, and description.

You can search for security alerts and signatures at this URL:

http://tools.cisco.com/security/center/search.x

Restrictions and Limitations

The following restrictions and limitations apply to Cisco IPS 7.1(5)E4 software and the products that
run it:

e The IPS 4345 and IPS 4360 do not support hardware bypass. Hardware bypass is currently only
supported on the IPS 4270-20.

e The ASA 5512-X IPS SSP and the ASA 5515-X IPS SSP do not support the Regex accelerator card
and the String XL engines.

e Applying any signature template erases any existing tunings associated with the targeted signature
definition file. The IPS 4240, IPS 4255, IPS 4260, ASA 5500 AIP SSM, ASA 5512-X IPS SSP, and
ASA 5515-X TIPS SSP do not support signature signature templates (signature threat profiles).

e The IPS 4240, IPS 4255, IPS 4260, ASA 5500 AIP SSM, ASA 5512-X IPS SSP, and
ASA 5515-X TIPS SSP do not support HTTP advanced decoding.

e Enabling HTTP advanced decoding can have a significantly negative performance and memory
impact on the sensor.

e Use the show statistics virtual-sensor | include load command (CLI) or look at the statistics for
the virtual sensor at Configuration > Sensor Monitoring > Support Information > Statistics
(IDM/IME) to determine the load value over a longer period of time. The show statistics
analysis-engine command (CLI) and the statistics for Analysis Engine show values over a shorter
period of time. If you compare the output, the values will appear to be inconsistent due to the
different time periods. To get an accurate comparison between them, compare the processing load
percentage from the statistics for the virtual sensor and the one-minute averaged value from the
statistics for Analysis Engine.
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Restrictions and Limitations

On IPS sensors with multiple processors (for example, the IPS 4260 and IPS 4270-20), packets may
be captured out of order in the IP logs and by the packet command. Because the packets are not
processed using a single processor, the packets can become out of sync when received from multiple
processors.

In IPS 7.1, rx/tx flow control is disabled on the IPS 4200 series sensors. This is a change from IPS
7.0 where rx/tx flow control is enabled by default.

TACACS+ authentication is not supported in IPS 7.1(5)E4.

The CLI timeout feature is applicable only for sessions established through SSH, Telnet, and the
console. Service account logins are not affected.

Anomaly detection does not support IPv6 traffic; only IPv4 traffic is directed to the anomaly
detection processor.

IPv6 does not support the following event actions: Request Block Host, Request Block Connection,
or Request Rate Limit.

Global correlation does not support IPv6.
There is no support for IPv6 on the management (command and control) interface.

ICMP signature engines do not support ICMPvV6, they are IPv4-specific, for example, the Traffic
ICMP signature engine. ICMPV6 is covered by the Atomic IP Advanced signature engine.

CSM and MARS do not support IPv6.

When deploying an IPS sensor monitoring two sides of a network device that does TCP sequence
number randomization, we recommend using a virtual senor for each side of the device.

For IPS 5.0 and later, you can no longer remove the cisco account. You can disable it using the no
password cisco command, but you cannot remove it. To use the no password cisco command, there
must be another administrator account on the sensor. Removing the cisco account through the
service account is not supported. If you remove the cisco account through the service account, the
sensor most likely will not boot up, so to recover the sensor you must reinstall the sensor system
image.

After you upgrade any IPS software on your sensor, you must restart the IDM to see the latest
software features.

The IDM does not support any non-English characters, such as the German umlaut or any other
special language characters. If you enter such characters as a part of an object name through IDM,
they are turned into something unrecognizable and you will not be able to delete or edit the resulting
object through IDM or the CLI. This is true for any string that is used by the CLI as an identifier,
for example, names of time periods, inspect maps, server and URL lists, and interfaces.

When the SensorApp is reconfigured, there is a short period when the SensorApp is unable to
respond to any queries. Wait a few minutes after reconfiguration is complete before querying the
SensorApp for additional information.

The IDM and IME launch MySDN from the last browser window you opened, which is the default
setting for Windows. To change this default behavior, in Internet Explorer, choose Tools > Internet
Options, and then click the Advanced tab. Scroll down and uncheck the Reuse windows for
launching shortcuts check box.
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Caveats

This section lists the resolved and unresolved caveats, and contains the following topics:

Resolved Caveats, page 69

Unresolved Caveats, page 70

Resolved Caveats

The following known issues are resolved in the 7.1(5)E4 release:

CSCty53045—sensorApp memory leak in GC network participation logic
CSCtx92869—4270 7.1(3) S623 sig update fails: Unable to create String XL signature
CSCty20170—Transmit control-plane cmgr messages as soon as possible from ips to asa
CSCtz05137—After IPS-SSP 7.1(4)E4 Update to S636, sensorApp hangs, int stat errors
CSCty26501—4270 not processing traffic post reboot until \"packet display\" is issued
CSCtw78334—SSM is unresponsive - TIPC kernel module failure
CSCty05171—sensorApp failure in StreamDispatchProcessor after update to S625/5626
CSCtj67834—inline-mode asym on promiscuous int prevents TCP stream reassembly
CSCtl03702—sensorApp aborts in SignatureProcessor processWithLocks
CSCtx90077—sensorApp fails with 'SpinLock not locked' after a reconfiguration
CSCtx48594—sensorApp fails with 'SpinLock not locked' during rgxMalloc
CSCty46104—mainApp fails during radius authentication in strlen/write AbstractEvent
CSCtz91790—global correlation updates are not downloading correctly on SSM-40
CSCtr19702—CLI/IME connection to IPS going down due to CT issue for FlexLM license
CSCtr83959—copy from file to current-config fails if auto-upgrade user is in file
CSCts08725—IDCONEF does not escape double quotes in signature names
CSCtt18382—ENH: IDS Web Server Should Not Break Comm With RFC 5746 Clients
CSCtt41378—IDS: Evaluate if sensor software is vulnerable to CVE-2009-0159
CSCtt41381—IDS: Evaluate if sensor software is vulnerable to CVE-2011-1071
CSCtw90697—MSRPC signature continues to fire after disabled and retired
CSCtx19960—os fingerprinting (osfp) fails to detect some XP/2k3 conversations
CSCtx21544—Radius authentication for pwds with special characters fails with SSP
CSCtx98802—Broken Links in Chapter 17 of CLI Config Guide for IPS 7.1
CSCty05217—sensorApp core in abandonChanges with custom config and CSCtx92869
CSCty07510—rgxMalloc errors need to be summarized

CSCty07097—rgxMalloc and mmap failures prior to sensorApp hang
CSCty49128—Buffer allocation issue if strip-telnet-options is true w/string-x1
CSCty93188—IPS incorrectly acts as a proxy for TCP keepalives
CSCte74540—AIP-SSM deny-connection on GRE packet causes GRE tunnel to be denied
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CSCtu10453—IPS-4GE-BP-INT should disable smartspeed to avoid unneeded downshift
CSCtg33102—IPS: Enh. to warn users when modifying TCP Normalizer signatures
CSCtf19088—Processing Load Percentage CLI output is inaccurate
CSCte63032—Processing Load should be changed to Inspection Load
CSCte46321—Need a means to view historical Processing Load

CSCto80933—IPS: Enabling Asymmetric Protection Mode should warn Anomaly Detect
CSCua(07735—Saleen: show inventory should show both serial numbers
CSCtl74475—CPU usage statistics are not relevant

CSCtj98418—IPS: Enhancement request to log an event when a user reboots the sensor.

CSCtg69012—IPS bypass logs should indicate reason for enabling bypass

Unresolved Caveats

The following relevant issues are unresolved in IPS 7.1(5)E4:

CSCty24588—missed packet percentage parameter is missing from PoO interface in 55xx
CSCtz03125—SSM module gets reloaded on \"downgrade\" and gets into bypass
CSCtz32230—CLI session terminates, cores on defaulting network-participation config
CSCty92038—GC not assigning score for alerts from malicious IPs

CSCtz47509—LSI soft error observed during coverage testing

CSCua32785—Sig. Downgrade from S649 to S648, retains Signature configs
CSCua34716—Network participation Connection Interval value is not fixed as configed
CSCty75384—misleading cli description for service-smb-advanced sig options
CSCtz03162—\"downgrade\" command gives incorrect version in warning and status event
CSCtz03202—show stats GC does not clear connection history and updates time
CSCtz03391—unable to login to radius user account with empty user role

CSCua40354—\"show statistics global\" does not show warning when UNLICENSED
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Related Documentation

For a complete list of the Cisco IPS 7.1 documentation and where to find it, refer to the following URL:
http://www.cisco.com/en/US/docs/security/ips/7.1/roadmap/19889_01.html

For a complete list of the Cisco ASA 5500 series documentation and where to find it, refer to the
following URL:

http://www.cisco.com/en/US/docs/security/asa/roadmap/asaroadmap.html
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Obtaining Documentation, Using the Cisco Bug Search Tool, and
Submitting a Service Request

For information on obtaining documentation, using the Cisco Bug Search Tool (BST), submitting a
service request, and gathering additional information, see What’s New in Cisco Product Documentation
at: http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html.

Subscribe to What’s New in Cisco Product Documentation, which lists all new and revised Cisco technical
documentation, as an RSS feed and deliver content directly to your desktop using a reader application. The
RSS feeds are a free service.

This document is to be used in conjunction with the documents listed in the “Related Documentation” section.
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Cisco trademarks, go to this URL: www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The
use of the word partner does not imply a partnership relationship between Cisco and any other company. (1110R)
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